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Inledning

Tack for att du valt Medtronic Diabetes som din partner for att underlatta fér dig och dina

patienter att styra diabetesbehandlingen. Vi tror att du kan ha nytta av CarelLink® Pro-

programmets banbrytande teknik och enkla, menystyrda anvandargranssnitt.

Med CareLink Pro kan du ta fram, lagra och rapportera patienternas behandling och

diagnostiska uppgifter. Du kan ocksa anvdanda programmet for att ta fram glukosdata fran

pump, matare och sensor som dina patienter har 6verfort till CareLink® Personal, ett

webbaserat behandlingssystem som anvands tillsammans med CareLink Pro.

Funktioner

CarelLink Pro adr en programvara for diabetesbehandling som ska anvéndas pa en persondator.

Programmet har féljande funktioner:

Patientjournaler kan skapas for att lagra uppgifter som samlats in fran en patients enhet och
aven behandlingsuppgifter fran patientens CarelLink Personal-konto.

Uppgifter fran insulinpumpar, monitorer och blodsockermdtare kan skickas till systemet,
sparas och sedan anvandas for att generera rapporter.

CarelLink Pro kan @ven samverka med CareLink Personal-systemet, sd att det gar att komma
at enhetsdata som patienterna har sparat. Det dr en anvandbar funktion om man vill ta fram
aktuella rapporter mellan patientens kontrollbesok, eller om man vill slippa lasa av uppgifter
fran enheten under kontrollbeséken.

Olika behandlingsrapporter kan skapas med de uppgifter fran enheten som sparats i
patientjournalen. Rapporterna kan ge svar pa fradgor kring behandlingen som t.ex. patientens
respons, monster och undantag.

Systemet anger automatiskt nar det finns nya versioner av programvaran som kan hamtas
och installeras. Pa sd satt vet ni sakert att ni alltid har tillgang till de senaste funktionerna.

Det finns en hjalpfunktion som hjadlper anvdandare som inte kdnner till CarelLink Pro.
Hjalpfunktionen kommer med tips om de uppgifter patienten utfér.

Programvaran omfattar ett integrerat hjadlpsystem som ger information om vissa punkter.
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Sakerhet

«  Carelink Pro kan skyddas med ett I6senord.

- Overféringen av patientuppgifter fran CarelLink Pro krypteras med tekniken Secure Sockets
Layer (SSL), som ar standard inom branschen.

Relevanta dokument

Denna bruksanvisning innehaller inte specifik produktinformation. Nedanstdende dokument
kan ge dig utforlig information om olika produkter:

OBSERVERA: Vad gdller mdtare fran andra tillverkare hdnvisas till bruksanvisningarna som
foljer med dessa mdtare.

«  Bruksanvisningen till Paradigm Insulinpump

«  Bruksanvisningen till Guardian REAL-Time-monitor
«  Bruksanvisning till sensorfunktioner

«  Bruksanvisningen till ComLink

«  Bruksanvisningen till CareLink USB

Hjalp

Kontakta Medtronic-representanten i ditt land om du behdver mer hjalp med systemet. Pa
foljande webbsida finner du internationell kontaktinformation:

http://www.medtronicdiabetes.com/help/contact/locations.html

Kompatibla enheter

CarelLink Pro hamtar data fran féljande enheter:

OBSERVERA: Vissa enheter som stéds av denna programvara kanske inte finns tillgdngliga
i alla ldander ddir programvaran har godkdnts for anvdndning.

Medtronic MiniMed-pumpar: 508

511,512, 712, 515, 715, 522, 722, 522K, 722K,

s ) . O oo
Medtronic MiniMed-pumpar i Paradigm®-serien: Paradigm® Veo™ (554, 754)

CSS-7100
CSS-7100K

Guardian REAL-Time-monitorer:
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Medtronic Diabetes partnerenheter:

Bayer:

Bayer Ascensia® DEX®-familjen, inklusive foljande
kompatibla matare:

Bayer CONTOUR® LINK
Blodsockerméatare BD Paradigm Link®

Ascensia BREEZE®
BREEZE® 2
CONTOUR®

Ascensia® DEX®
Ascensia® DEX® 2
Ascensia® DEXTER-Z® Il
Glucometer® DEXTER-Z®
Ascensia® ESPRIT® 2
Glucometer® ESPRIT®
Glucometer® ESPRIT® 2

Abbott:

FreeStyle®

FreeStyle® Lite®
FreeStyle® Freedom®
FreeStyle® Freedom Lite®
Precision Xtra™
TheraSense FreeStyle®
FreeStyle® Flash®
FreeStyle® Papillon™ mini
FreeStyle® Mini®

Optium Xceed™

Precision Xceed™

CareLink Pro Anvandarhandbok
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Com-Station

Blodsockermdtare Paradigm Link®

Datakommunikationskabel

Anvands med Medtronic MiniMed 508 pump. (Se
bruksanvisningen till Com-Station for narmare
information om den maskinvara som kravs.)

Anvdnds med MiniMed Paradigm-pump och
Guardian REAL-Time-monitor. (Se
bruksanvisningen till Paradigm Link®
blodsockermatare for narmare information om
den maskinvara som krévs.)

Anvands med blodsockermatare fran andra
tillverkare. Varje matartillverkare bifogar en
datakommunikationskabel.

Observera: Om en matartillverkare tillhandahaller
en USB-kabel i stéllet for en seriell kabel for
datadverforing ska du installera
programdrivrutinen fran den tillverkaren.

Kontrollera ocksa med tillverkaren av mataren om
USB-drivrutinen ar kompatibel med ditt
operativsystem. Vissa USB-drivrutiner kanske inte
finns tillgdngliga for 64-bitars operativsystem.

Motsvarande enheter

Om du vill lagga till en enhet till systemet ska du vadlja marke och modell pa en lista. Om

market och modellen inte finns med pa listan kan du hitta en motsvarande enhet i tabellen

nedan.

. Bayer Ascensia® DEX® 2

. Bayer Ascensia® DEXTER-Z® ||
. Bayer Glucometer® DEXTER-Z®
. Bayer Ascensia® ESPRIT® 2

. Bayer Glucometer® ESPRIT®

. Bayer Glucometer® ESPRIT® 2

Precision Xceed™

Bayer Ascensia® DEX®

Optium Xceed™

Bestdllning

Kontakta en lokal Medtronic-representant om du vill bestdlla Medtronic Diabetes-produkter.

Anvand foljande URL for att fa tillgang till internationell kontaktinformation:

http://www.medtronicdiabetes.com/help/contact/locations.html
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OBSERVERA: Mdtarna kan bestdllas fran de respektive tillverkarna.

Sa har anvander du bruksanvisningen

OBSERVERA: | denna bruksanvisning visas exempel pa skdrmar. Skédrmarna i den verkliga

programvaran kan avvika en aning fran dessa.

| ordlistan finner du forklaringar till termer och funktioner. De skrivsdtt som anvands i denna
bruksanvisning beskrivs i nedanstadende tabell.

Tryck pa den vanstra musknappen Over ett objekt

Klicka pa skdarmen for att vélja objektet.

Tryck tva ganger pa den vanstra musknappen over

SuleldiEe ett objekt pa skarmen for att 6ppna objektet.

Tryck pa den hogra musknappen over ett objekt
Hogerklicka pa skdrmen for att visa ett annat fonster eller en
annan meny.

Anvands for knappar, skarmar, faltnamn eller

Fetstil menyalternativ. Till exempel: Patient > New
Patient
OBSERVERA: Ger ytterligare information om ett forfarande eller

steg.

Varnar for en maojlig risk, som, om den inte
OBS! undviks, kan leda till mindre eller medelsvara
skador pa programvaran eller utrustningen.

Indikerar en mgjlig risk, som, om den inte
undviks, kan leda till dédsfall eller allvarlig

VARNING: personskada. Kan ocksa beskriva mojliga allvarliga
biverkningar och sakerhetsrisker.
Anvandarsakerhet

Indikationer for anvandning

CarelLink Pro-systemet ar avsett att anvandas som ett verktyg for att underlatta
diabetesbehandling. Syftet med systemet ar att omvandla information fran insulinpumpar,
blodsockermatare och system med kontinuerlig blodsockerévervakning till CareLink Pro-
rapporter. Rapporterna ger information som kan anvandas for att identifiera trender och folja
dagliga aktiviteter, sdsom antalet kolhydrater, mattider, insulindosering och
blodsockervarden.

Varningar

«  Systemet dr avsett att anvdndas av sjukvardspersonal som har erfarenhet av
diabetesbehandling.
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«  Systemresultaten ar inte avsedda att ge medicinsk rddgivning och man far inte satta tillit till
dem i sddant syfte.

«  Produkten ska endast anvandas tillsammans med de enheter som anges i detta dokument.
(Se Kompatibla enheter pa sidan 2.)

«  Patienterna ska rekommenderas att kontrollera blodsockervdrdet minst 4-6 ganger om
dagen.

«  Patienterna ska uppmanas att inte andra behandlingen utan att samrdda med
sjukvardspersonalen.

- Patienterna ska uppmanas att fatta beslut om behandlingen utifran sjukvardspersonalens
riktlinjer och resultaten av blodsockermatningar, inte utifran glukossensorvardena.

Kontraindikationer

Denna programvara far inte anvandas med andra enheter an de som raknas upp under
Kompatibla enheter pa sidan 2. Produkten far heller inte anvdandas for behandling av andra
medicinska tillstand an diabetes.

Stang alla aktiva program pa din dator innan du 6ppnar de har programmen:
«  CGMS’® System Solutions™ programvara (7310)

«  Solutions’ Pumps & Meters programvara (7311)

«  Guardian® Solutions’ programvara (7315)

«  ParadigmPAL™ (7330)

«  CareLink® Personal programvara (7333)

.  Solutions’ programvara for CGMS’iPro (7319)
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Forberedelser

Pa foljande sidor beskrivs hur du startar CareLink Pro, 6ppnar och stanger patientjournaler

och staller in preferenser som galler for alla patienter i systemet.

Innan du borjar

Om det ar forsta gangen du anvander Carelink Pro maste du stdlla in dina allménna

preferenser (se Allmédnna preferenser pa sidan 12). Dessa instéllningar avgor hur vissa saker

visas i programvaran och pa rapporter samt hur du vill att systemet ska kommunicera med

Internet.

Installningarna kan goras nar som helst. Det kan handa att du vill vanta tills du har bekantat

dig med CareLink Pro innan du stéller in andra preferenser.

Primdra systemuppgifter

| tabellen nedan visas de huvuduppgifter som du formodligen vill utfora férsta gangen du

staller in och anvander CarelLink Pro. Dessutom anger den var i bruksanvisningen du kan hitta

information om de olika uppgifterna.

Bekanta dig med CareLink Pro-grdanssnittet.

Navigera inom systemet pa sidan 8

Definiera de overgripande systemval som kliniken ska
anvanda.

Stdlla in systempreferenser pa sidan 12

Skapa profiler for alla patienter.

Ldgga till nya profiler pa sidan 21

Lanka till patienternas' CareLink Personal-konton.

Ldnka till CareLink Personal pa sidan 22

Lagga till patienternas' pumpar och matare till deras
profiler.

Ldgga till en enhet pa sidan 29

Lasa av uppgifter fran patienternas pumpar och matare.

Ldsa av uppgifter fran en enhet pa sidan 35

Stélla in och generera rapporter for alla patienter.

Skapa rapporter pa sidan 38
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Gora regelbundna sakerhetskopior av CarelLink Pro-
databasen.

Sdkerhetskopiera databasen pa sidan 48

Uppdatera CareLink Pro.

Programvaruuppdateringar pa sidan 47

Navigera inom systemet

Du bor bekanta dig med anvdndargranssnittet innan du boérjar arbeta med CareLink Pro.

Anvandargranssnittet omfattar menyer, ett verktygsfalt, ett navigationsfalt, arbetsomraden

och ett hjadlpfonster.

Oppna CareLink Pro

1 Dubbelklicka pa CareLink Pro-ikonen H pa datorns skrivbord eller vélj Medtronic
F =

CarelLink Pro i programlistan i Windows startmeny.

Om kliniken kraver att du anger ett 16senord sa visas inloggningsskdarmen.

a. Skriv in ditt I6senord i Password-faltet (Losenord).

OBSERVERA: Losenordet dr en tillvalsfunktion som stdlls in under

installationsprocessen.

b. Klicka pa LOGIN.

Startskarmen visas.

2 Klicka pd New Patient (Ny patient) om du vill starta en ny patientrapport. Om du vill 6ppna

en befintlig patientrapport ska du klicka p& Open Patient (Oppna patient).

Arbetsomraden

Om en patientrapport ar 6ppen kan du klicka pd en av knapparna i navigeringsfaltet for att

visa motsvarande arbetsomrade. Anvand dessa arbetsomraden for att mata in eller vilja

information sa att CareLink Pro-uppgifterna fér den patienten kan utforas.

Profile: Gor att du kan spara
patientinformation som namn och
fodelsedatum. Det hér arbetsomradet tillater
dven en lank till patientens CarelLink Personal-
konto.

s

Devices (Enheter): Gor att du kan spara
information som kravs for att kunna avldsa en
patients enheter.

[=]) (&)

Reports (Rapporter): Gor att du kan vilja
parametrar och rapporter som ska genereras
for patienten.
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Innan en profil har lagts till och sparats for en patient ar det bara arbetsomradet Profile (Profil)
som ar tillgangligt for den patienten. Innan enheter har lagts till for en patient ar det bara
arbetsomrddena Profile (Profil) och Devices (Enheter) som dr tillgdngliga for den patienten.

Verktygsfalt

CareLink Pros verktygsfalt ger snabb dtkomst till funktioner som anvands ofta. Féljande
knappar finns i verktygsfaltet.

Oppnar ett arbetsomrade for
% Ligg till patient Profile (Profil) sa att du kan
L lagga till en ny patientjournal
till systemet.

Oppnar tabellen Patient Lookup
q Oppna patient (Patientsokning) dar du kan
— vdlja vilken befintlig
patientjournal du vill visa.

Visar eller doljer hjalpfonstret.
Hjilp Klicka for systemhjélp som tar
.- hansyn till var du befinner dig i
systemet.

Patientflikar

Efter att du har 6ppnat en patientjournal visas en flik bredvid verktygsfaltet med patientens
namn. Nar en flik ar aktiv innebar det att en patients journal och arbetsomrdde ar aktiva och
att du kan utféra CareLink Pro-uppgifter fér patienten.

=& Medtronic Carelink® Pro

File Wiew Tools Language Help | @ q r

P ﬂ Mew Patient [

Om du vill géra en patients journal aktiv sa att du kan arbeta med den klickar du pa fliken for
denna patient. Stang journalen genom att klicka pa Close (Stang) E3 pa fliken.
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Hjalpfunktionen

Det finns en hjalpfunktion i hela CareLink Pro. Den 6ppnar ett fonster med hjdlp och tips om

handlingar som kan utféras i den del av systemet som ar aktivt. Hjdlpfonstren kan dven ha

lankar till >>learn more (lar mer). Om du klickar pd dem tar ldnkarna dig till det relevanta

avsnittet i onlinehjalpen foér mer information. Standardinstaliningen ar att hjalpfunktionen ar

aktiverad. Det gar dock att stdnga av den nar som helst.

Start up window

IF you choose ko add & new patient, a

blank Frofie warkspace is daplaved. IF
you choose o open an exisking patien:
reczed, the Cpen Fabent vandow is

displayzd,

#¥ learmn mare

What next? & |

T wou ae adding a new patienc, yoo wil
complece Hhelr prafile.

#¥ learn nre
IF you &'e opening an exsting patisn:,

Yol Cand o

Ll

SIa av och pa hjalpfunktionen

Du kan sla pa/av hjalpfunktionen genom att géra nagot av det féljande:

+  Klicka pd Guide Me (Hjdlp). 2

« Valj Help > Guide Me.
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Oppna patientjournaler

Upp till sex patientjournaler kan dppnas samtidigt. Se Ldgga till nya profiler pd sidan 21 om

du inte har skapat nagra patientprofiler annu.

1

Vilj File > Open Patient (Fil, Oppna patient) eller klicka pd knappen Open Patient (Oppna

patient). @& En patientlista som paminner om den féljande visas.

“u Upen Patient

Find a Palienk || oeam S
[ Drat & of

| Firsk Mame Last Mame Birth Patient 10

SAMPLE PATENT 2071475 ]

Sanple Ptierk? 10471963 100001

Sanple Pstierkd A 1570 100002

@ oPEN | [ cance

OBSERVERA: Om du fdr ett meddelande om att alltfér mdanga patientjournaler dr
oppna ska du klicka pa OK, stinga en journal och sedan fortsdtta.

Sok patienter genom att skriva in hela eller delar av deras namn i faltet Find a Patient (Hitta
en patient). Nar den patient du sékte markeras ska du klicka p& knappen OPEN (OPPNA) och
dubbelklicka pa raden eller trycka pd ENTER. Du kan dven navigera igenom listan med

piltangenterna upp och ned pa tangentbordet.

Patientens arbetsomrdde Devices (Enheter) (om inga enheter har lagts till 4n) eller Reports

(Rapporter) visas.

Klicka pa knappen Profile (Profil) | [@]| i navigationsfaltet om du vill visa patientens

S

arbetsomrade Profile.

Stanga patientjournaler

1

Kontrollera att den patientjournal du vill stanga ar aktiv (fliken ar markerad).

2 Gor nagot av foljande:

a. Valj File > Close Patient (Fil, Stang patient).
b. Klicka pa knappen Close (Stédng) E pa patientens flik.
c. Tryck pa Ctrl + F4,
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Stalla in systempreferenser

Dessa preferenser galler for alla patienter i systemet. Mer information om preferenser som

endast paverkar enskilda patienter finns i Bekrdfta rapportinstdllningarna pd sidan 41.

Preferenserna visas i féljande grupper:

«  General (Allmant)
- Blodsockerenheter
- Kolhydratenheter
- Kommunikation
- Felsdkning

- Patient Profile (Patientprofil)
- Vadlj och arrangera datafdlten om patientprofiler.

«  Patient Lookup (Patientsokning)

- Anpassa och dndra ordningen pa de félt som visas d& du viljer Open Patient (Oppna

patient) for att ta fram en lista med patienter.

+  Report Generation (Generera rapporter)

- Valj vilka datafalt du vill visa da du i datatabellen viljer vad som ska inga i Daily Detail-

rapporten.

Allmanna preferenser

Anvand fliken General (Allmant) for att definiera hur programmet visar olika typer av

information och for att stélla in dina preferenser for extern kommunikation.

1 Klicka pa fliken General (Allmant) om den inte ar aktiv.

2 Valj Tools > Options (Verktyg, Alternativ). Féljande fonster visas.

S okl fovcrs For comPLREATESE Bl UNEE of SR SRS 35 mam fmm

Afpiorer Usls Casbaolrpiale Uty
el (5] .

% 5 o e el 0o 0 D

Uhast (gdumes et sl

[Fves v Hepents o By
] Crmmresa P 0o B g 1oy i st el et o

o Creeilay T T ]
Charigen sl ke affuck e rast e you burch e spplcation

Tk i wey
| hape 5 snagrbest el eveny dewide 6 el el s i dat a b o
Mt e

(Brirmisns bma recgned i 1aad s cdivost)

3 Klicka pa knappen for att valja det varde du vill ha:
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7

- Glucose Units (Glukosenheter): mmol/l eller mg/dI
- Carbohydrate Units (Kolhydratenheter): gram eller utbyten

a. Om du vidljer Exchanges (Utbyten) for Carbohydrate Units (Kolhydratenheter) ska du
skriva in motsvarande siffra i faltet grams are equal to 1 Exchange (gram motsvarar 1
utbyte).

Markera eller avmarkera rutan i avsnittet Chart Options > Overview Report
(Diagramalternativ, Oversiktsrapport). Om rutan &r markerad kommer programmet att binda
samman BS-vdrdena i diagrammet Meter Glucose Overlay med linjer. (Det har diagrammet
visas i oversiktsrapporten for sensorer och métare.)

Markera rutan (aktivera) eller avmarkera rutan (inaktivera) for foljande
kommunikationspreferenser:

OBSERVERA: Se till att du féljer klinikens eller dataavdelningens riktlinjer da du
stdller in kommunikationspreferenserna.

- Automatically check for software updates (S6k automatiskt efter
programuppdateringar): om detta alternativ har valts skickas ett meddelande till alla
system med CareLink Pro sa snart det finns en programuppdatering. Anvdndaren har da
mojligheten att hamta och installera uppdateringarna. Om du féredrar en kontrollerad
distribution av uppdateringar ska denna ruta avmarkeras.

- Synchronize with Medtronic CareLink® Personal (Synkronisera med Medtronic
CareLink® Personal): Markera denna ruta om du vill att systemet automatiskt
synkroniserar dina patienters' CarelLink Personal-uppgifter varje gang du 6ppnar deras
profiler. Om denna ruta avmarkeras maste du manuellt synkronisera CarelLink Personal-
uppgifterna for varje patient.

Markera eller avmarkera rutan i avsnittet Troubleshooting (Felsokning). Om rutan ar
markerad kommer programmet att spara en rapport med avldsningar av enheten for
felsdkning.

Klicka pa OK for att spara de allmanna preferenserna.

Preferenser for patientprofiler

Det har d@r en dvergripande instdllning som definierar profilernas innehall. Du kan anpassa

falten i arbetsomradet Profiles (Profiler) for att de ska innehalla den information som ar mest

relevant for kliniken. Du kan ldgga till eller ta bort félt, skapa dina egna anpassade falt och

bestamma faltens visningsordning i fonstret.

1

Vilj Tools > Options (Verktyg, Alternativ).
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2 Klicka pa fliken Patient Profile (Patientprofil). Féljande fonster visas.
S8 Uplians
_ET Patent Profiie Patient Losin Piegart Geseraton
Foit and peder the dabs Fiskds that shioukd bes displ sesd 26 ot OF Ches Dotenk profle # han men
Bt ification Dotals Faahl Oedior
Pergini riell Rirguirid * Firgt Mame 3=
it Wame v [iendes ! . -
[l rsickiie: Mo - [ iiageass g =
ast Manae s Dabn af Birth ]
[#] Pabieat B0 (mid Patient By -
[l ite af Bath a-
[Cevefin
[ Sallix
Fomgi rmd Emquired
[C#ane ' [l | Cs
[ClEmait - = .
[ClCall Phone - ~
ubens ' Ot
D&? ! D Loy
[ otabe ! z '
mF ' Ojes
[JCaumbry ' L o '
CAMCEL
OBSERVERA: Markera rutorna for de falt du vill ha med i profilen. Anvédnd upp- och
nedpilarna fér att ldgga fdlten i rdtt ordningsféljd.
Vilja datafalt
1 Markera rutorna for att lagga till de falt du vill ha.
OBSERVERA: Férnamn och efternamn kan inte tas bort.
2 Avmarkera rutan om du vill ta bort ett falt fran profilen.
3 Om fdltet ska vara obligatoriskt ska rutan i kolumnen Required (Obligatoriskt) markeras. Alla

falt som ar obligatoriska maste fyllas i innan det gar att skapa en profil.

Lagga till ett anpassat falt

1
2

Markera rutan till vanster om ett tomt anpassat falt.

Skriv in text sa att fdltet far ett namn (t.ex. Kontaktperson i nddlagen). Det faltnamnet
kommer att visas pa patientprofilen.

Om féltet ska vara obligatoriskt ska rutan i kolumnen Required (Obligatoriskt) markeras.

OBSERVERA: Om du vill ta bort ett anpassat filt fran profilen ska du avmarkera rutan
bredvid de(t) fdlt du vill ta bort.
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Andra ordningen pa datafilten
Valj det falt du vill flytta och klicka pa upp- eller nedpilen : ; for att flytta det. (Pilen Overst

och nederst flyttar faltet till den Oversta eller understa positionen pa listan.)

Slutfora preferenserna for patientprofiler
Klicka pa OK néar du har fatt med alla falt du vill ha, i ratt ordning.

Nu har patientprofilerna alla falt, i den ordning, som du valt.

Preferenser for patientsokning

Tabellen Patient Lookup (Patientsdkning) anvands for att soka och 6ppna patientjournaler.
Denna tabell omfattar alla patienter i databasen och med hjalp av den kan man hamta
identifieringsuppgifter fran patientprofilerna'. Du kan anpassa informationen som visas i denna
tabell och ordningen i vilken kolumnerna visas. Gor sa har for att anpassa tabellen Patient
Lookup (Patientsékning):

1 Valj Tools > Options (Verktyg, Alternativ).

2 Klicka pa fliken Patient Lookup (Patientsdkning). Foljande fonster visas.

Gemesal  Pabent Prodiie Patient Losdup Fiegaor b Erpmenya biom
Faipt swhich ek shoukd be d splepad in the patlsnt ook Lol Fr b ros
Wiewable Dpka Fields by Desplay Oeder
* First B First Name gl
* Lank Mar Last Marme:
Fl  DCoteof Btk Mrats of trth o
[l Patsent Palient B
I oK CANCEL

OBSERVERA: Markera rutorna fér att vilja de uppgifter du vill ha med i tabellen
Patient Lookup (Patients6kning). Anvidnd upp- och nedpilarna fér att Idigga
kolumnerna i réitt ordningsfoljd.

Vilja vilka uppgifter ska visas

Markera rutorna for att valja vilka uppgifter du vill visa, eller avmarkera rutorna fér uppgifter
du inte vill visa i tabellen Patient Lookup (Patientsékning).
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Andra kolumnernas ordningsféljd
Om du vill andra ordningsfoljden pa kolumnerna i tabellen Patient Lookup (Patientsékning)
=

ska du vélja den kolumn som ska flyttas och klicka pa upp- eller nedpilarna. (Pilen o6verst

kS
och nederst flyttar kolumnen till den Oversta eller understa positionen pa listan.)
Den kolumn som star 6verst pa listan Column Display Order (Visningsordning fér kolumner)

kommer att visas som forsta kolumn i tabellen Patient Lookup (Patientsékning). Den kolumn
som star nederst kommer att visas som sista kolumn i tabellen.

Slutfora preferenserna for patientsékning
Klicka pad OK néar du har fatt med alla kolumner du vill ha, i ratt ordning.

Tabellen Patient Lookup (Patientsokning) har nu uppgifterna och kolumnerna i den ordning
du valt.

Preferenser for rapportgenerering

Datatabellen visas i fonstret Select and Generate Reports (Valj och generera rapporter). Den
har tabellen anvands vid rapportering. Den innehdller dagliga uppgifter hamtade fran
patienternas enheter och, om tillampligt, deras CareLink Personal-konton. Med hjalp av
uppgifterna som visas i denna tabell kan du bestdmma vilka dagar du vill ha en Daily
Detail-rapport over. Du kan aven valja vilka andra rapporter du vill generera.

Kliniken kan anpassa uppgifterna som visas i tabellen, inklusive ordningen i vilken de visas,
sa att tabellen endast innehaller den information som ar mest relevant for klinikens
verksamhet.'

OBSERVERA: Mer information om hur dessa preferenser pdaverkar datatabellen da
rapporten skapas finns i Vilja rapporttyper och datum som ska omfattas pd sidan 43.

1 Valj Tools > Options (Verktyg, Alternativ).
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2 Klicka pa fliken Report Generation (Rapportgenerering). Féljande fonster visas.

& Uplisns

General  PotentProffe  Pabent Losip Fiegart Generabon
St the datathat shoudbe deplrsed in thes report Ssisctan S geneeraton step »ir lnar reon
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[ Lowest ®eadng [Ce ol Bnlrses
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Tatal Tn sl |
Mgmal
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LCarhs Total

Sensar Averpe

Vilja vilka uppgifter ska visas

Markera rutorna for att valja vilka uppgifter du vill visa, eller avmarkera rutorna fér uppgifter

du inte vill visa i datatabellen.

Foljande uppgifter kan inkluderas i datatabellen.

Ne of Meter Readings (Antal mataravlasningar)

Antal avlasningar vid det angivna datumet som
registrerats av enheterna.

Meter Readings Average (Mataravlasningar,
genomsnitt)

De genomsnittliga blodsockervardena som
registrerats av enheterna.

Sensor Duration (Sensorvaraktighet)

Tidsperioden inom det angivna datumet for vilken
sensoruppgifter registrerats. Vardena ar -- (inget),
0:05 - 24:00.

Sensor Average (Sensor, genomsnitt)

De genomsnittliga sensoravldsningarna som
registrerades vid det angivna datumet.

Highest Reading (HOgsta avldsning)

Det hogsta blodsockervérdet (fran en sensor eller
matare) vid det angivna datumet.

Lowest Reading (Lagsta avldsning)

Det lagsta blodsockervardet (fran en sensor eller
matare) vid det angivna datumet.

Avg AUC Below Target (Genomsnittl. AUK under mal)

Den genomsnittliga arean under kurvan ligger under
patientens malomrade

Avg AUC Above Target (Genomsnittl. AUK 6ver mal)

Den genomsnittliga arean under kurvan ligger 6ver
patientens malomrade

Total Carbs (Summa kolhydrater)

Summan av alla kolhydratméngder (avrundad till
narmaste gram eller ndrmaste 0,1 utbyte, beroende
pa den mattenhet som anvands) rapporterad under
dagen via Bolusguidehdndelser eller
kolhydratmarkorer pd pumpen eller Guardian-
monitor.
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N2 of Rewinds (Antal aterstéllningar)

Antal aterstallningshéandelser vid det angivna
datumet.

Prime (or Fill) Volume (U) (Volym for primes eller
pafyliningar)

Total Basal (U) (Summa basal)

Basal %

Sammanlagd volym insulin som anvants for
primehdndelser (eller pafyliningshandelser) vid det
angivna datumet.

Sammanlagd volym basalinsulin som getts vid det
angivna datumet (total mdngd insulin som getts,
minus summan av alla bolusar som getts).

Visar forhallandet (i hela procentvéarden) mellan
basalinsulin och total méngd insulin.

Antal bolushédndelser som registrerats vid det
angivna datumet.

Ne of Boluses (Antal bolusar)

Bolus Wizard Overrides (Bolusguide, avvikelser)

Ne of Correction Boluses (Antal korrektionsbolusar)

Antal bolusguidehdndelser i vilka mdngden doserad
insulin skiljer sig fran den rekommenderade

mangden.

Antal bolusguidehédndelser med korrektionsmédngder
over noll som registrerades vid det angivna
datumet.

Andra kolumnernas ordningsféljd

Om du vill andra ordningsfoljden pa kolumnerna i datatabellen ska du vélja den kolumn som

ska flyttas och klicka pa upp- eller nedpilarna :

;_ (Pilarna overst och nederst flyttar

kolumnen till den Oversta eller understa positionen pa listan.)

OBSERVERA: Punkter som stdr overst pa listan Column Order (Kolumnordning) kommer

att visas som forsta kolumn i datatabellen. Punkter som stdr nederst kommer att visas

som sista kolumn i datatabellen.
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Slutfora preferenserna fér rapportgenerering
Klicka pad OK néar du har fatt med alla kolumner du vill ha, i rdtt ordning.

Datatabellen har nu uppgifterna och kolumnerna i den ordning du valt.
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Arbetsomradet Profile (Profil)

En profil motsvarar framsidan pa en journal. Den innehaller patientuppgifter som namn och
fodelsedatum. En profil kravs innan uppgifter kan samlas in fran enheten och anvandas for
rapporter om behandlingen.

eanio, e O I

e

Pabient Profille 55 e el
| —
* First Mame L0000
——l # Last Mamwe
;ﬂ_ Date of Birth ||
—
Drvices Patient D
B}
Peolile

¥ daleiy patand o
muﬂnmmmm B3 b wues

Sabuss Nk inded

| L 0 exrsTiG Accoust |

l SEND E-MAIL INVTTATDON TO PATIENT

Arbetsomradet Profile (Profil) gor det dven mdjligt att lagga in en lank till patientens CarelLink
Personal-konto. Efter att lanken har lagts in kan du nar som helst hamta patientuppgifter som
sparats i CarelLink Personal — utan att patienten behdver vara dar.

Innan du borjar

Det kan hadnda att du vill anpassa patientprofilerna sa att de bara innehaller den typ av
information som du vill samla in. Lds mer om detta under Preferenser for patientprofiler pa
sidan 13.
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Det kravs ett anvandarnamn och ett I6senord for att kunna lagga in en lank till patientens

CarelLink Personal-konto. Patienten maste vara narvarande for att tillhandahalla dessa

uppgifter.

Lagga till nya profiler

Varje gang du vill ldgga till en patient till CareLink Pro-systemet maste du borja med att fylla i

en profil for patienten.

1

Vilj File > New Patient (Fil, Ny patient) eller klicka pad knappen Add Patient (Lagg till
patient). g

Arbetsomradet Profile (Profil) visas.

OBSERVERA: Klicka pa Customize fields (Anpassa fdlt) for att Idgga till eller dndra fdlt
i patientprofilen. Se Preferenser f6r patientprofiler pa sidan 13.

Fyll i falten i avsnittet Patient Profile.
Klicka pd SAVE (SPARA).

Den nya patientprofilen laggs till i CareLink Pros databas. Ett bekraftelsemeddelande om att
profilen har sparats visas.

Fyll i de obligatoriska falten

1

Om ett obligatoriskt falt inte har fyllts i da patientprofilen sparas visas ett meddelande
bredvid det féltet. Det gdr inte att spara profilen innan det faltet har fyllts i.

Fyll i faltet.
Klicka pa SAVE (SPARA).

Klicka pa OK nar bekraftelsemeddelandet visas.

Redigera patientprofiler

A W N

Kontrollera att patientens arbetsomrade Profile (Profil) ar ppet.
Klicka pa EDIT (REDIGERA).

Redigera de uppgifter som ska andras i avsnittet Patient Profile.
Klicka pa SAVE (SPARA).

Ett bekraftelsemeddelande om att profilen har sparats visas.

Radera patientuppgifter ur systemet

1

Kontrollera att patientens arbetsomrade Profile (Profil) ar oppet.
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2 Kontrollera att det ar just den patienten du vill radera. Om en patientprofil raderas innebar
det ocksa att alla uppgifter i CareLink Pro-databasen raderas och det kan inte dngras.

3 Klicka pad >> delete patient record (radera patientjournal) ovanfor synkroniseringsavsnittet
pa profilen.
Ett meddelande visas som varnar dig om att alla patientuppgifter kommer att raderas nar du

tar bort journalen.

4 Klicka pa Yes (Ja) for att ta bort patientjournalen.

Lanka till CareLink Personal

Om patienten tillater det kan du ldgga in en lank till patientens CareLink Personal-konto.
Detta webbaserade verktyg gér det mojligt for patienterna att skicka och spara uppgifter som
hamtats fran deras enheter samt kora olika behandlingsrapporter.

Efter att du har lankat till patientens CarelLink Personal-konto kan du hamta de uppgifter fran
enheten som sparats dar. Detta ar praktiskt om du vill skapa CarelLink Pro-
behandlingsrapporter mellan patientens kontrollbesdk. Dessutom innebar det att enheten
sallan eller aldrig behdver avldasas under patientens kontrollbesok.

Om en patient inte har ndgot CareLink Personal-konto kan du mejla patienten och uppmana
honom eller henne att skapa ett.

Lanka till ett befintligt konto

OBSERVERA: Patienten madste vara ndrvarande for att dessa steg ska kunna slutféras.

1 Kontrollera att du har Internetanslutning.
Oppna patientens arbetsomrade Profile (Profil).

Kontrollera att alla obligatoriska falt i avsnittet Patient Profile (Patientprofil) ar ifyllda.

H W N

Klicka pa LINK TO EXISTING ACCOUNT (LANKA TILL BEFINTLIGT KONTO).
CareLink Personals inloggningsskarm visas.

5 Be patienten att:
a. Skriva in anvandarnamn och |6senord.

b. Klicka pa Sign In (Logga in).

Sidan Grant Access (Bevilja atkomst) visas, baserad pa patientens registreringsinstallningar
for sprak och region.

6 Be patienten att:
a. Ldsa igenom Terms of Use (anvdndarvillkoren).
b. Klicka pa rutan bredvid | agree to the Terms of Use above... (Jag accepterar villkoren
ovan).
c. Klicka pa Grant Access (Bevilja atkomst).

d. Tala om for dig nér sidan Thank You (Tack) visas.
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7 Vid behov kan du skriva ut anvandarvillkoren at patienten genom att klicka pa knappen Print
(Skriv ut). Nu har du en lank till den har patientens CareLink Personal-konto.

Mejla en inbjudan

GOr sd har for att mejla en inbjudan till en patient om att 6ppna ett CarelLink Personal-konto:

1 Oppna patientens arbetsomrade Profile (Profil).

2 Kontrollera att alla obligatoriska falt i avsnittet Patient Profile (Patientprofil) ar ifyllda.

3 Klicka pda SEND E-MAIL INVITATION TO PATIENT (MEJLA INBJUDAN TILL EN PATIENT).

SO E-Mal Inwitation

Patient Mame  [Sairs rari |

E-Mail Address |
Lenguage |Erglih -
Subjmct [ingser 1o 0 ok

MSccage | Do SALE FOTIENT: -

4 Kontrollera att Patient Name (Patientnamn), Email Address (e-postadress) och Language
(Sprak) har fyllts i korrekt.

5 Klicka pd SEND (SKICKA).

| patientens profilstatusomrade bekrdftas att mejlet har skickats.

Hamta uppgifter fran ett lankat konto

Om du har lankat till en patients CareLink Personal-konto kommer alla nya uppagifter fran
detta konto att skickas automatiskt varje gang du 6ppnar patientprofilen i CarelLink Pro.

OBSERVERA: For att sdkerstdlla att detta sker ska du ga till Tools > Options > General
(Verktyg, Alternativ, Allmdnt) och kontrollera att rutan bredvid "Synchronize with
CarelLink Personal” (Synkronisera med Carelink Personal) dr markerad.

FoOlj dessa steg for att hamta en patients CareLink Personal-uppgifter nar som helst efter att du
har 6ppnat den patientprofilen:

1 Kontrollera att patientens arbetsomrade Profile (Profil) ar 6ppet och att du ar ansluten till

Internet.
2 Vailj Tools > Synchronize Patient Data (Verktyg, Synkronisera patientuppgifter).

Synkroniseringsikonen ¢§ pa patientens flik roterar. Da ikonen stannar har processen

slutforts.
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OBSERVERA: Om patienten inte Icingre vill dela sina CareLink Personal-uppgifter visas
ett meddelande som informerar dig om detta.

3 Alla ytterligare uppgifter som hamtats fran CarelLink Personal visas i patientrapporterna.

Koppla bort en patients CareLink Personal-konto fran CareLink Pro

Du kan koppla bort en patients CarelLink Personal-konto fran CarelLink Pro. Detta ar endast
mojligt efter att en patient har blivit lankad. Det forhindrar CarelLink Pro fran att fortsatta samla
in data fran patientens CareLink Personal konto. Det paverkar inte patientens anvandning av
sitt CareLink Personal-konto.

1 Oppna patientjournalen och du kommer till arbetsomrédet Profile (Profil).
2 Klicka p& UNLINK ACCOUNT (TA BORT LANK TILL KONTO).
3 Klicka pa Yes (Ja) for att bekrafta. Patientens profil ar inte langre kopplad till CareLink Pro.

Statusen andras till Not linked (Inte lankad) och knapparna LINK TO EXISTING ACCOUNT
(LANKA TILL BEFINTLIGT KONTO) och SEND E-MAIL INVITATION TO PATIENT (MEJLA
INBJUDAN TILL PATIENT) visas nu.
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Maskinvaruinstallning

For att kunna lasa uppgifter direkt fran en enhet maste du ha tillgéng till patientens enhet och
ha de kablar eller kommunikationsenheter som kravs for att overféra data till datorn.

Om patienten har overfort uppgifterna fran sin enhet till sitt CareLink Personal-konto kan du
aven komma at uppgifterna genom att lanka till detta konto. Se Lénka till CareLink Personal pa
sidan 22 for information om hur du kan lénka till en patients CareLink Personal-konto.

Ansluta enheter

Granska oversiktsdiagrammet for att fa en allman uppfattning om hur enheter ska stallas in for
att kunna kommunicera med datorn. Féljande diagram illustrerar specifika aspekter av

enhetens kommunikation.

Mer information finns i de instruktioner som CareLink Pro visar da du laser av enheter.
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Oversikt dver maskinvaruinstallningar

Det hadr exemplet visar hur CareLink USB anvands for kommunikation mellan pumpen och

datorn.

Exempel pa anslutning med seriell kabel respektive USB-kabel:
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Valfri ComLink for anvdndning med pump i Paradigmserien:

Valfri Com-Station for anvandning med Medtronic MiniMed 508 pump:
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Arbetsomradet Devices (Enheter)

Informationen som du behover for att kunna ldsa av en patients enhet, t.ex. marke, modell
och serienummer, sparas i arbetsomradet Devices (Enheter). Den behover alltsa inte anges

varje gang du laser av uppgifter fran enheten.
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Enheter i arbetsomradet Devices (Enheter) sparas pa en av tva listor: Active Devices (Aktiva

enheter) eller Inactive Devices (Inaktiva enheter). Nar du lagger till en enhet hamnar den
automatiskt pa listan Active Devices (Aktiva enheter). Du kan bara ldsa av uppgifter fran
enheter som visas pa listan Active Devices (Aktiva enheter). De ar sannolikt de enheter som

din patient anvander.

Andra enheter som patienten kan ha, men som han eller hon inte anvander just nu, kan sparas

pa listan Inactive Devices (Inaktiva enheter). Det gor att informationen sparas och att dessa

enheter kan aktiveras nar det behodvs.

CareLink Pro Anvéandarhandbok

Arbetsomradet Devices (Enheter)
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Innan du borjar

Innan du kan 6ppna arbetsomradet Devices (Enheter) for en patient maste han eller hon ha en
profil som sparats i systemet. Se Ldgga till nya profiler pa sidan 21.

For att du ska kunna ldgga till en enhet eller ldasa uppgifter direkt fran den maste den
kommunicera med datorn. | Ansluta enheter pad sidan 25 beskrivs hur du ska stélla in enheter s
att de kan kommunicera med datorn.

Lagga till en enhet

Du kan hamta uppgifter frdn en patients CareLink Personal-konto fér en enhet som inte lagts
till annu. Sddana enheter ldggs automatiskt till ndr uppgifter synkroniseras mellan CareLink
Personal och CareLink Pro.

OBSERVERA: Det kan bara finnas en aktiv pump per patient. Om du Idgger till en ny pump
flyttas den tidigare till den inaktiva listan.

Lagga till en Medtronic-pump eller Guardian-monitor

1 Kontrollera att den enhet du ldgger till ar instélld sa att den kan kommunicera med datorn.

(Se Ansluta enheter pa sidan 25 for de olika anslutningsstegen.)

2 Klicka pa patientfliken eller dubbelklicka pa patientens namn i tabellen Patient Lookup

(Patientsokning).

|
3 Klicka pa Devices ﬁ| (Enheter) for att komma at patientens Devices-arbetsomrade.

4 Klicka p4 ADD DEVICE (LAGG TILL ENHET).

5 Vilj Medtronic Pump/Guardian. Guiden Add Medtronic Pump/Guardian (Lagg till

Medtronic Pump/Guardian) visas.

&8 Add Medironic Pump J Guardian

Made| Selection Step 1 z 1 i

Saslact the Meckronic devices you veould b Eo add bo the systen.

3 e Fem

(%) Mindhed 508 pump

(Tl Minded Paradgm Seres pumg
Hind¥ied! Guardian RESL-Tme monibor

| mexr | | casn

OBSERVERA: Pumpmodellen anges pa pumpens baksida eller pa pumpstatusskdrmen.
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6 Klicka pa knappen som avser den enhet du vill lagga till.
Om du har valt alternativet MiniMed 508 pump ska du ga du vidare till steg 9.
7 Klicka p& NEXT (NASTA). Sidan Serial Number (Serienummer) visas.

o Add Medtronic Pamp J Guardian

Serial Mumbser Step 1 z 3 !

Ereerbhe device's sx charadter s=iel number, Fourd on the bach of the deuiee or on the skabus
screan. Sarial numbers may conbain lotters as wall as numbers.

B3 |y moe

Device Serial Number:

OBSERVERA: Ett felmeddelande visas om du anger fel serienummer. Titta pa exemplen
pa den hdr sidan och kontrollera att du har angivit samma uppgifter som pa
pumpens baksida. Skriv in de sex tecknen pd nytt om det behévs.

8 Anvand exemplen pa den héar sidan for att hitta serienumret (bestaende av sex tecken) pa
den enhet du ska ldgga till. (Om du behdver mer hjalp for att hitta numret kan du klicka pa
>>learn more (mer information).) Skriv in de sex tecknen i filtet Device Serial Number
(Enhetens serienummer).

9 Klicka p& NEXT (NASTA). Sidan med Communication Options (Kommunikationsalternativ)
som paminner om den foljande visas.

& Add Medtronic Pump § Guardian

Camimisnicalian Dptions Step. 1 2 3 i
Chaogse which port your connectivity dewvice & attached ko,
55 loam mary
Choose Port:
é ] At Debect (or LSH) b
I
Bace || mExT | | camcE |

10 Klicka pa nedrullningsmenyn Choose Port (Vilj port) och valj den port som ComLink,
Paradigm Link’, CareLink USB eller Com-Station ansluts till pd din dator. Om du inte &r siker
pa vilken port som ar den ratta valjer du Auto Detect (or USB) (Automatisk identifiering
(eller USB)).
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11 Klicka pd NEXT (NASTA). Sidan Test Connection (Testa anslutningen) som ser ut som den

foljande visas.

& hdd Medtranic Pump § Guardian

Test Conme bion Slen i 2 1 L]

Teest the corrsctaoan n onder Lo complebe e sl deace protess.
B uminey & Parsscliom Link. devics, verify E i OFF before contirurag.

¥ g s

Dewvioe:
Par achrs pummg | Gubrdian REAL-Time ,u
Seriall Mumber:
et 55
Cammmimication: ]
Auko Detect {or LISH) i I‘

-

el |

| eace || mesT | | casm |

12 Folj enhetens instruktioner och klicka pa TEST.

Ett meddelande visas for att ange om anslutningen lyckades eller inte. Om den lyckades ska
du ga vidare till nasta steg.

OBSERVERA: Det hdir testet Idiser inte av ndgra pumpuppgifter utan bekrdftar bara att
kommunikationen mellan pumpen och datorn fungerar.

Om den inte fungerar ska du kontrollera att maskinvaran mellan enheten och datorn har
anslutits pa ratt satt. Klicka aven pa BACK (TILLBAKA) pa sidorna i guiden for att kontrollera
att du angivit ratt uppgifter om enheten.

13 Klicka p4 DONE (FARDIG).

Enheten har lagts till patientens lista Active Devices (Aktiva enheter).

Lagga till en matare

1

Klicka pa patientfliken eller dubbelklicka pa patientens namn i tabellen Patient Lookup
(Patientsokning).

Kontrollera att den matare du lagger till kommunicerar med datorn. (Se Ansluta enheter pa

sidan 25 for de olika anslutningsstegen.)
Klicka pa knappen Devices (Enheter) for att komma at patientens Devices-arbetsomrade.

Klicka pd knappen ADD DEVICE (LAGG TILL ENHET).
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5 Valj Blood Glucose Meter (Blodsockermatare). Guiden Add Blood Glucose Meter (Ldgg till
blodsockermadtare) visas.

2 Add Blood Glucose Metor

Meter Brand Sep 1 2 3 |

St the brand of maber e weould Bl 1o a4 o the System

PEap—
(% Medtrenic Link Meters
(hieea-Chekf (Roche)
C Ascension (Bayer)
180
(i Medisense® | TheraSense® {Abbott)
CrneTouch (LfeScan)

e [ ] [owen

6 Klicka pa alternativknappen for att ange market pa mataren.

7 Klicka p& NEXT (NASTA). Sidan Meter Model (Mitarmodell) visas (denna sida ser olika ut
beroende pa matarens tillverkare).

o Add Blood Glucose Maler El

Feter Model Siep | z 1 i

Choose the Madtronds Link meter you would B to add Eo the system,

B ¥ g Frem
' i
|
8 ll

a0 ~ Gayer | OreTouchs
IParasdigm Link i (COMT IS Link Ll k™

[ oacx || texr | [cance |

8 Klicka for att vélja den matarmodell som du lagger till.

CareLink Pro Anvandarhandbok  Arbetsomradet Devices (Enheter) 32



9 Klicka p& NEXT (NASTA). Sidan Communication Options (Kommunikationsalternativ) visas.

& Add Blood Glucose Malor

Comrmmiricabiodn Options L2 N | z

X

Choose wihich poet the matar & connectad ko,

B i e

Choose Pork:

| acx | | e |

| eanceL |

OBSERVERA: Det gdr bara att vilja de alternativ som dr giltiga fér den mdtare du

Idgger till.

10 Klicka pa nedrullningsmenyn Choose Port (Vdlj port) och vélj den port som ComlLink,

Paradigm Link eller CareLink USB ansluts till pa din dator. Om du inte ar saker pa vilken port

som &r den ratta valjer du Auto Detect (or USB) (Automatisk identifiering (eller USB)).

11 Klicka pd NEXT (NASTA). Sidan Test Connection (Testa anslutningen) visas.

&oAdd Blood Glucose Malor

Tesk Conmection Liep ] 7

X

¥ 4

Tt Hre conneschon i order bo complets the add devics process,
Before reading your meter, verily vour meter is ON,

FE T

Devvige:
Brayres COMNT CUEL Link.

R Detect

| oacx | | rest |

| eanceL |

12 Folj matarens instruktioner och klicka pa TEST.

Ett meddelande visas for att ange om anslutningen lyckades eller inte. Om den lyckades ska

du ga vidare till nasta steg.
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Om den inte fungerar ska du kontrollera att maskinvaran mellan enheten och datorn har
anslutits pd ratt satt. Klicka aven pa BACK (TILLBAKA) i guiden for att kontrollera att du
angivit ratt uppagifter.

13 Klicka pA DONE (FARDIG).

Mataren har lagts till patientens lista Active Devices (Aktiva enheter).

Aktivera eller inaktivera en enhet

Patientenheterna kan flyttas mellan listorna Active Devices (Aktiva enheter) och Inactive
Devices (Inaktiva enheter) efter behov. En enhet maste vara aktiv for att man ska kunna lasa av
uppgifter fran den.

Du kan ha sa manga matare du vill pa listan Active Devices (Aktiva enheter), men bara en
pump. Kontrollera att du verkligen vill inaktivera den aktuella pumpen innan du lagger till en

ny.
Inaktivera en enhet

1 Klicka pa patientfliken eller dubbelklicka pa patientens namn i tabellen Patient Lookup

(Patientsokning).

2 Klicka pa knappen Devices (Enheter) for att komma at patientens Devices-arbetsomrade.
Enheterna kan finnas med pa listan med ett motsvarande namn. Se Kompatibla enheter pa

sidan 2.

3 Klicka pa >> make this device inactive (inaktivera den har enheten) under den enhet du vill

inaktivera. Enheten flyttas till listan med Inactive Devices (Inaktiva enheter).

Ateraktivera en enhet

1 Klicka pa patientfliken eller dubbelklicka pa patientens namn i tabellen Patient Lookup

(Patientsokning).
2 Klicka pa knappen Devices (Enheter). Patientens arbetsomrade Devices (Enheter) visas.

Enheterna kan finnas med pa listan med ett motsvarande namn. Se Kompatibla enheter pa
sidan 2.

3 Klicka pa >> activate this device (aktivera den har enheten) under den enhet du vill aktivera.

Enheten flyttas till listan Active Devices (Aktiva enheter).

Radera en enhet

GOr sd har for att radera en enhet och dess uppgifter frdn arbetsomradet Devices (Enheter) och
CareLink Pro-systemet:

1 Klicka pa patientfliken eller dubbelklicka pa patientens namn i tabellen Patient Lookup

(Patientsokning).

2 Klicka pa knappen Devices (Enheter) for att komma at patientens Devices-arbetsomrade.
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Enheterna kan finnas med pa listan med ett motsvarande namn. Se Kompatibla enheter pd
sidan 2.

Kontrollera att enheten finns med pa listan Inactive Devices (Inaktiva enheter). Om den inte
gor det ska du klicka pa >> Inactivate this device (Inaktivera denna enhet) pa den lista dar
den star nu.

Klicka pa >> delete this device (radera den har enheten) under den enhet du vill radera. Ett
meddelande visas som varnar dig om att enheten och alla dess uppgifter kommer att raderas
fran patientens journal.

Klicka pa YES (JA) for att radera enheten.

Enheten och dess uppgifter tas bort fran arbetsomradet Devices (Enheter) och fran CarelLink

Pro-systemet. Uppgifter fran den har enheten kan inte langre anvédndas i rapporter.

Lasa av uppgifter fran en enhet

Ett satt att fa uppgifter fran en enhet ar att lanka till patientens befintliga CarelLink Personal-

konto. (Se Ldnka till CareLink Personal paG sidan 22.) Ett annat satt ar att lasa av dem direkt fran

enheten, pa det satt som beskrivs har.

Uppgifter fran patientens enhet kan ldsas av CarelLink Pro om enheten finns med pa listan

Active Devices (Aktiva enheter) och om den kommunicerar med datorn. Efter att du har fatt

fram de har uppgifterna kan du anvanda dem fér att skapa rapporter som underlattar

beddmningen av patientens behandling. Se Om rapporter pa sidan 44 for en kort beskrivning

av de tillgangliga rapporterna.

CareLink Pro kan samla in foljande uppgifter fran en insulinpump:

Olika installningar pa pumpen, som alarmldget, signalvolymen och tiden
Tillforda basaldoser insulin

Bolushdndelser och tillforda mangder

Information fran Bolusguiden

Primingméangder

Stopperioder

Sensorglukosvdrden under en tidsperiod, pa pumpar med sensorfunktioner

Systemet kan ocksa samla in foljande data fran ett Guardian REAL-Time-system:

Sensorglukosvdrden (SG)
Sensorkoefficientvarden
Sensorkalibreringsfaktorer
Maltidsmarkorer

Insulininjektioner

Dessutom kan olika typer av information som lagrats i en blodsockermatare 6verforas till

systemet under avlasning av enheten.
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VARNING: Avbryt eller slutfor alla tempordra basaldoser eller aktiva bolusar och radera
alla aktiva alarm. Pumpen stoppas under avldsningen. Kontrollera att pumpen startar
igen efter att avldsningen har slutforts.

OBS! Anvidind inte fjdrrkontrollen dd pumpen avlédses. Om pumpbatteriet ndstan dr tomt
skickar pumpen inte ndgra uppgifter till datorn. Byt ut batteriet om statusen anger att

batteriet dr ndstan tomt.

1 Klicka pa patientfliken eller dubbelklicka pa patientens namn i tabellen Patient Lookup
(Patientsokning).

2 Kontrollera att patientens enhet kommunicerar med datorn. (Se Ansluta enheter pd sidan 25.)
3 Klicka pa knappen Devices (Enheter) for att komma at patientens Devices-arbetsomrade.

Enheterna kan finnas med pa listan med ett motsvarande namn. Se Kompatibla enheter pa
sidan 2.

4  Lokalisera den enhet du vill hamta uppgifter fran i listan Active Devices (Aktiva enheter), och

se till att uppgifterna under Choose port (Vilj port) ar korrekta.

For pumpar klickar du pa nedrullningsmenyn Amount of Data (Antal uppgifter) och viljer
den méangd uppgifter du vill att CareLink Pro ska ldsa av.

5 Klicka p&d motsvarande knapp READ DEVICE (LAS AV ENHET).
6 Folj specifika instruktioner for enheten och klicka pa OK.

7 Carelink Pro visar en forloppsindikator som visar hur stor del av avlasningen som har
slutforts.

Om du klickar pa CANCEL (AVBRYT) under avlasningen av enheten visas ett
varningsmeddelande om att avbrott av atgarden kan goéra att alla uppgifter som hittills
avlasts gar foérlorade. Du maste klicka pd knappen READ DEVICE (LAS AV ENHET) for att
starta om avldsningen.

- Klicka pa YES (JA) for att avbryta.

- Klicka pa NO (NEJ) om du vill fortsatta att ldsa av uppgifterna.

Nar systemet har avslutat avlasningen visas ett meddelande som bekraftar att avlasningen av

enheten ar klar.

8 Klicka pa OK.
- Se pumpens bruksanvisning om du vill starta den igen.

Om CarelLink Pro inte kan hamta uppgifter fran enheten, se Felsokning for mer information.
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Arbetsomradet Reports (Rapporter)

CarelLink Pro-programvaran tillhandahaller olika rapporter som hjélper dig att battre hantera
dina patienters diabetesbehandling. Informationen som varje rapport innehaller dr baserad pa
de uppgifter du far fran patientens enheter och hans/hennes CarelLink Personal-konto.
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Rapporter kan genereras pa skdarmen, skickas direkt till en skrivare eller sparas som TIFF- eller
PDF-filer som du kan bifoga till en Electronic Medical Record (EMR). Du kan generera flera

olika slags rapporter genom en enda atgard.

De uppgifter som visas i dessa rapporter hamtas fran patientens enheter, fran hans/hennes

CarelLink Personal-konto eller fran bada.

OBSERVERA: Mer information om rapportkomponenterna och provrapporter finns med i
Report Reference Guide (Referensguide foér rapporter). Du kan komma dt referensguiden
for rapporter i CarelLink Pro genom att ga till Help>View Report Reference Guide (PDF)
(Hjdlp>Visa referensguiden for rapporter (PDF)) och sedan viilja ditt sprdk.

Innan du borjar

Om du vill visa uppgifterna fran en viss tidsperiod i en rapport maste du hamta uppgifterna
om den perioden fran patientens enhet. Det kan dven handa att patientens enhet maste
anslutas till datorn fér att hamta aktuella uppgifter innan det gar att skapa rapporter.
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Kontrollera uppgifterna under steget Verify Report Settings (Bekrafta rapportinstdllningar)
innan du skapar en rapport. Dar kan du finjustera en rapport sa att du far fram just de

patientuppgifter som du vill ha.

Skapa rapporter

| de foljande avsnitten beskrivs vilka rapporter som finns tillgangliga for dig samt vilka

atgarder du maste vidta for att generera dem.

Om du redan ar bekant med rapporteringsprocessen och vet vilka rapporter du vill kéra kan

du boérja generera rapporter med en gang.

Oppna arbetsomradet Rapporter

Klicka p& patientfliken eller knappen Open Patient (Oppna patient) & och dubbelklicka pa
patientens namn.

Arbetsomradet Reports (Rapporter) visas.

OBSERVERA: Klicka pa SYNC DATA (SYNKRONISERA UPPGIFTER) for att scdkerstdlla att du
far de senaste uppgifterna om enheten fran patientens CarelLink Personal-konto.

Valja rapporteringsperiod

1 Om du vill andra hur lang tid rapporten/rapporterna ska omfatta klickar du pa
nedrullningsmenyn Duration (Tidsperiod) och valjer en tidslangd. (Den langsta tidsperioden
ar 12 veckor.)

2 Fran-och-med- och till-och-med-datum stalls in automatiskt om du inte véljer alternativet

custom date range (anpassa datumintervall).

OBSERVERA: Om du viiljer en tidsperiod som dr Idngre dn den Idngsta tillatna visas
ett felmeddelande. Andra tidslingden eller datumen.

Om du vill stélla in datumen sjélv ska du klicka pa nedrullningsmenyn From (Fran och med)

eller Through (Till och med) och sedan védlja manad, datum eller ar.

Kalender

Kalenderomradet i arbetsomradet Reports (Rapporter) visar ett fonster pa tre manader for
rapportering av information.
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De bld omradena motsvarar uppgifter fran enheten. Det orangea omradet motsvarar
rapporteringsperioden som du har valt. Overlappningar mellan uppgifter frdn enheten och
rapporteringsperioden innebdr att det finns uppgifter for ndgra eller alla de
rapporteringsperioder som visas.
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Kalenderomradet visar inledningsvis de senaste tre mdnaderna. Om du vill se andra manader

ska du klicka pa piltangenterna ¢ # i borjan eller slutet av perioden.

Valja vilka uppgifter ska finnas med

1 Om patienten har en BS-matare som dar lankad till sin pump, klicka for att vélja ett av de
foljande alternativen for rapportering av mataruppgifterna:

- Frdn pumpen: Férdelarna med det har alternativet ar bland annat att du bara behover
ldsa av uppgifter fran patientens pump, blodsockervardena tidsstamplas av pumpen och
vardena kopplas direkt till den bolusberdkning som anvants. En nackdel ar att om det
uppstar kommunikationsproblem mellan pumpen och den lankade mataren sa kan det
handa att blodsockervardena for den perioden inte rapporteras. Dessutom kan det, om
patienten har en MiniMed Paradigm-pump aldre an 522/722, handa att de
blodsockervarden fran Bolusguideberakningarna som inte lett till fordandringar inte
rapporteras.

- Frdn ldnkad/ldnkade mdtare: Fordelen med det har alternativet ar att alla vdarden som
sparats i den lankade mataren rapporteras. Nackdelen ar att du maste kontrollera att
pumpen och matarens klockor var synkroniserade for att kunna samordna uppgifter fran
mataren och pumpen. Det kan alltsa handa att du maste ldsa av uppgifter fran pumpen
och den lankade mataren separat.

2 Markera rutan bredvid enheten om du vill att uppgifter fran enheten ska tas med i
rapporterna.

Det gar inte att lagga till enheter som undantogs vid valet under steg 1. Om du vill andra
detta ska du vilja det andra lankade mataralternativet.

3 Avmarkera rutan bredvid enheten om du inte vill att uppgifter fran den enheten ska tas med
i rapporterna.

Det gar inte att avmarkera enheter som togs med vid valet under steg 1. Om du vill dndra
detta ska du valja det andra lankade mataralternativet.
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Kontrollera uppgifter fran enheten

1

Se efter i kalenderomradet i arbetsomradet Reports (Rapporter) om det orangea omradet
som motsvarar rapporteringsperioden overlappar de bld omradena som motsvarar enhetens
uppgifter.

Om det finns 6verlappningar for hela rapporteringsperioden finns det uppgifter for din(a)
rapport(er). | s& fall kan du klicka p& NEXT (NASTA) och g4 till Bekrdfta rapportinstdllningarna
pa sidan 41.

Om det inte finns ndgon o6verlappning, eller om dverlappningen inte ar tillracklig, finns det
nagra alternativ:

- Justera rapporteringsperioden.

- Hamta ytterligare uppgifter fran enheten.

Hamta ytterligare uppgifter fran enheten

1

Klicka p& knappen READ DEVICE (AVLAS ENHET) som hor till en viss enhet om du vill ha mer
uppgifter fran den.

Faltet for avldasning av enheten visas.
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VARNING: Avbryt eller slutfor alla tempordra basaldoser eller aktiva bolusar och
radera alla aktiva alarm. Pumpen stoppas under avidsningen. Kontrollera att pumpen
startar igen efter att avidsningen har slutforts.

OBS! Anviind inte fjdrrkontrollen da pumpen avidses. Om pumpbatteriet ndistan dr
tomt skickar pumpen inte ndgra uppagifter till datorn. Byt ut batteriet om enhetens
statusskdrm anger att batteriet dr ndstan tomt.

Kontrollera att uppgifterna i faltet Choose port (Valj port) ar de ratta for den har enheten.

Om du vill dndra instéllningen ska du klicka pa nedrullningsmenyn for faltet och vélja en
annan installning.

Kontrollera att enheten ar ansluten till din dator.

Om enheten ar en pump kan du specificera hur manga uppgifter du vill ha fran den. Klicka pa

nedrullningsmenyn Amount of Data (Antal uppgifter) och valj en mangd.
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OBSERVERA: Om du viiljer All available data (Alla tillgdngliga uppgifter) Ildser
systemet av alla uppgifter. Ddrmed skrivs alla dubbla uppgifter i systemet over.

Klicka pA READ DEVICE (AVLAS ENHET). Las noggrant det meddelande som visas eftersom
det ger specifika instruktioner for hur pumpen ska lasas av.

Folj instruktionerna och klicka pa OK.

Forloppsindikatorn for avlasning av enheten visas.

Du kan ndr som helst avbryta avldsningen genom att klicka pa CANCEL (AVBRYT).
Ett bekraftelsemeddelande om att avlasningen ar klar visas.

Klicka pa OK.

Uppgifterna fran enheten visas nu i uppgiftskalendern.

Klicka pd NEXT (NASTA) 6verst i arbetsomradet Reports (Rapporter).

Steget Verify Report Settings (Bekrafta rapportinstallningar) visas. Det gor att du kan
kontrollera att instdllningarna for den har patienten ar korrekta innan du kor rapporterna.

Bekrafta rapportinstallningarna

1

Kontrollera att instdllningarna for Glucose Target (Blodsockermal) &@r korrekta. Skriv in de
ratta vardena eller klicka pa pilarna upp eller ned i falten Low (L3g) eller High (Hog) for att
hoja respektive sanka vardena.

OBSERVERA: Markdrer for mdataravldsningar (|| |) visas pa tidslinjen for uppvaknings-
och ldggningstid, samt pa tidslinjen for maltidsmarkérer. Eftersom en del av
rapporterna bygger pa uppgifter fran definierade mal-, uppvaknings- eller
Idggningstider, dr det viktigt att en patients markaérer for Bolusguidehdndelser och
mdtaravldsningar grupperas pa rdtt sdtt.

Klicka p& ADD MEAL (LAGG TILL MALTID) for att ldgga till en ny maltidsperiod. Klicka var som
helst pa tidslinjen inom en av maltidsperioderna for att redigera en befintlig maltidsperiod.

Fonstret for redigering av maltidsperioderna, som visas under tidslinjen, dppnas.

OBSERVERA: Du kan ha upp till fem maltidsperioder. Standardinstdllningen dr
frukost, lunch och middag.

Skriv in text eller klicka pa pilarna for att vélja de installningar du vill ha.

Om du bara vill anvanda dessa installningar for den har maltiden ska du avmarkera rutan
bredvid Use these parameters for all of this patient's meals (Anvand dessa parametrar for
alla den har patientens maltider).

- Meal Name (Maltidsnamn): det namn du vill ge maltidsperioden.

- Meal Time Period (Maltidsperiod): timmar dd maltiden intas.
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- Pre-Meal BG Target (Grénsvarden for blodsocker fore maltid, mg/dl eller mmol/l):
lagsta och hdgsta gransvardena for patientens blodsockervarde fore maltiden.

- Pre-Meal Analysis Period (Analysperiod fore maltid): den tidsperiod som blodsockret
analyseras fore en maltid. Glukosvardena fran den har tidsperioden anvands i detaljerade
rapportanalyser.

- Post-Meal BG Target (Grdansvarden for blodsocker efter maltid, mg/dl eller mmol/l):
lagsta och hogsta gransvardena for patientens blodsockervdrde efter maltiden.

- Post-Meal Analysis Period (Analysperiod efter maltid): den tidsperiod som
blodsockret analyseras efter en maltid. Glukosvardena fran den har tidsperioden anvédnds
i detaljerade rapportanalyser.

Du kan andra langden pa en befintlig period for maltider, uppvaknande och laggdags
genom att klicka pa start- eller slutligena och sedan dra perioderna ldngs tidslinjen.

OBSERVERA: Maltidsperioder kan inte éverlappa varandra, men start- och slutlinjerna
kan grdnsa till varandra. Mdltidsperioderna madste vara minst 60 minuter Idnga.

Om du vill anvanda de har maltidsinstallningarna for patientens samtliga maltider ska du
markera rutan bredvid Use these parameters for all of this patient’s meals (Anvand dessa
parametrar for patientens samtliga maltider).

Klicka pa SAVE (SPARA) efter att du har skapat eller redigerat en maltidsperiod.

Ta bort en maltidsperiod genom att klicka pd DELETE MEAL (TA BORT MALTID). Klicka pa
DELETE (TA BORT) nar du uppmanas att bekrafta.

CarelLink Pro kommer ihag dessa installningar for patienten ndsta gang du kor en rapport for
honom eller henne. Klicka p4 SAVE SETTINGS (SPARA INSTALLNINGAR) for att spara dem for
den har patienten.

Klicka pd NEXT (NASTA) éverst i arbetsomradet Reports (Rapporter).
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| det har steget kan du vélja och generera rapporter. Du kan vdlja en lista med rapporttyper
eller en datatabell som hjdlper dig att vdlja att ta med eller uteldmna uppgifterna fran vissa
dagar i de dagliga detaljrapporterna.
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OBSERVERA: Klicka pa >>customize columns (anpassa kolumner) om du vill dndra hur

datatabellen visas. Se Preferenser fér rapportgenerering pa sidan 16.

9 Klicka pa ikonen PRINT (SKRIV UT) for att skriva ut innehallet pa skarmen.

Vélja rapporttyper och datum som ska omfattas

1 Markera rutan bredvid de rapporter du vill ska inga i rapportuppsattningen.

2 Om uppgifter har lasts av fran en pump eller Guardian-monitor mer d@n en gang under
rapporteringsperioden kan det finnas flera snabboversikter over enhetsinstallningarna:
a. Kontrollera att rutan bredvid Device Settings Snapshot (Snabboversikt over
enhetsinstallningar) har markerats.
b. Klicka pa pilen i datumféltet och valj datum och tid for en snabbdversikt.
- Pumpar: Valj en snabboversikt over patientens pump.
- QGuardian: Vdlj en snabbdversikt 6ver patientens Guardian-monitor.

Om nagot falt ar skuggat finns det inga snabbéversikter for rapporteringsperioden.

3 Bladdra igenom datatabellen for att granska den tillgangliga Daily Detail-
rapportinformationen.
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- Du kan sortera uppgifterna i varje kolumn. Klicka pa kolumnrubriken for att sortera
uppgifterna i stigande ordning. Klicka pa rubriken igen for att sortera uppgifterna i
fallande ordning.

OBSERVERA: Om det inte finns ndagra uppgifter for ett visst datum gdr det inte att
vilja det.

4 Markera rutan vid datatabellraderna for de datum du vill ha en Daily Detail-rapport 6ver.
- Du kan ta med eller uteldmna alla datum fo6r Daily Detail-rapporter med ett enda klick
genom att markera eller avmarkera rutan over alla kryssrutor foér datum i datatabellen.

Generera rapporter

1 Efter att du har bekraftat valen for rapporter ska du klicka pa GENERATE REPORTS
(GENERERA RAPPORTER) overst i arbetsomradet Reports (Rapporter).

En lista med alternativ visas.
2 Valj hur du vill forhandsvisa, skriva ut eller spara rapporter.
Om du véljer Preview (Forhandsvisning), visas fonstret Preview.
3 Klicka pa pilarna for att navigera genom rapporter som bestar av flera sidor.
4 Klicka pa nagon av de andra knapparna overst i fonstret Preview (Forhandsvisning) for att

spara eller skriva ut rapporterna.

tats b bl @ e o® @ T ot to PO | ] Dxport to TUF | 5 Prink | 7] Report Relerence Guide - | [ Close

(¢, }

Sténg fonstret genom att klicka pa knappen Close (Stdang) E i fonstrets Ovre hdgra horn.

Om rapporter

| detta avsnitt beskrivs de olika rapporterna. Mer information om rapportkomponenterna och
provrapporter finns med i Report Reference Guide (Referensguide for rapporter). Du kan
komma dt Report Reference Guide (Referensguide fér rapporter) genom CareLink Pro-
programvaran:

1 Valj Help > View Report Reference Guide (PDF) (Hjalp, Visa referensguiden for rapporter
(PDF)).

2 Valj ett sprak for Report Reference Guide.
CareLink Pro-rapporterna har féljande gemensamt:

+  Rubrik — | rubriken finns information som identifierar rapporten, som rapportens namn,
patientens namn och varifran uppgifterna kommer.

«  Kolhydrater och blodsockervarden — Kolhydratenheterna visas kursivt och
blodsockervardena visas i fetstil i diagram och tabeller.

- Helguppgifter — Helgdagarna visas i fetstil sa att det gar latt att hitta dem.
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- Symbolférklaringar — En lista med symboler visas ldngst ned pé varje rapport. Aven om
symbolerna anvands i flera olika rapporter sa ar symbolforklaringarna unika for varje rapport.

Responsrapport

Responsrapporten visar data som beskriver hur insulinpumpar och sensorer anvands och
patientens beteende som ar av betydelse for behandlingen. Den besvarar frdgan "Fanns det
tillrackligt med uppgifter for att ge en riktig bild av hur patienten anvander sin insulinpump
och sensor, om detta ar relevant". Den besvarar ocksa fragan "Haller patienten sig till
behandlingen enligt givna instruktioner?" Rapporten visar pa om du behover prata med
patienten om hur han eller hon skoéter sin diabetes.

Sensor- och mataroversiktsrapport

Sensor- och mataroversiktsrapporten visar grafiskt patientens dagliga blodsocker- och
genomsnittsvarden fran sensor och matare, inklusive uppgifter per timme over hela dygnet
och hur vérdena ligger i forhallande till maltids- och somnmadnster. Dessutom ingar statistik
om patientens blodsockervarden och insulindosering.

En analys av sensordata genereras pa samma satt som forstasidan i denna rapport om
sensordata finns tillgangliga. Om inga sensordata finns kommer uppgifterna fran mataren att
genereras som forstasida.

Rapportens sista sidor visar nivderna dag fér dag och kvaliteten pd patientens glykemiska,
kolhydrat- och insulinkontroll. P4 varje sida visas hur kontrollen varierar dag for dag under
hela rapporteringsperioden med maximalt 14 dagar per sida.

Loggboksrapport

Loggboksrapporten visar matarblodsocker samt kolhydrat- och insulindata for varje dag
under rapporteringsperioden. Resultat visas timme fér timme och som dagliga medelvérden
och totalsummor. Varje sida innehaller upp till 14 dagar. Om rapporteringsperioden éverstiger
14 dagar genereras extra sidor.

Snabboversikt 6ver enhetsinstallningar

Rapporten Device Settings Snapshot (Snabbdversikt éver enhetsinstallningar) ger en
snabboversikt 6ver instadllningarna for patientens pump eller Guardian REAL-Time-monitor vid
ett specifikt datum och en specifik tidpunkt. Den kan hjélpa dig att forsta andra rapporter eller
helt enkelt dokumentera patientens instdllningar.

Pump- eller monitorinstallningarna registreras bara nar enheten lases av. Om enheten inte
avlastes under rapporteringsperioden finns inga installningar tillgangliga.
Daglig detaljrapport

Den dagliga detaljrapporten visar glukosdata, kolhydratmangder samt patientens
insulinanvandning under en vald dag. En separat rapport genereras for varje dag som valts i
datatabellen.
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Den dagliga detaljrapporten ger en detaljerad Oversikt 6ver alla dagar som valts. Den gor att
du kan fokusera pa en viss dag om ndgot av vikt for patientens behandling kan ha intraffat.

Exportera data

Du kan exportera data frdn enheten som hamtats och lagrats av CareLink Pro. Den ger dig alla
uppgifter fran patientens enhet sd att du kan anvanda dem for statistiken eller for att skapa
specialrapporter eller diagram. Filen (.csv) kan importeras till Microsoft Excel eller till vissa
kliniska statistikprogram dar uppgifterna kan bearbetas ytterligare.

Filen (.csv) innehdller uppgifter om enhetens aktiviteter. Den listar till exempel registrerade
matarvarden, att pumpen fatt ett varde fran mataren eller andringar av basaldosen.

OBSERVERA: Det dr en avancerad funktion som krdver att du kdnner till de rena
uppgifterna frdn enheten. Dessutom mdste du vara bekant med den programvara till
vilken du importerar CSV-filen.

Folj dessa instruktioner for att anvanda CareLink Pros exportfunktion:

1 Klicka pa patientfliken eller knappen Open Patient (Oppna patient) & och dubbelklicka pa
patientens namn.
2 Kontrollera att arbetsomradet Reports (Rapporter) visas.

3 Stall in datum och rapportlangd i falten Duration (Varaktighet) eller From/Through (Fran-
och-med/Till-och-med).

Den langsta period du kan valja ar 12 veckor.
4 Klicka pa lanken export selected data (exportera valda uppgifter).
Dialogrutan Export Data to CSV File (Exportera data till CSV-fil) visas.

5 Navigera till platsen dar du vill spara CSV-filen pa datorn. Om du vill andra filens namn ska du

skriva in det i rutan File name (Filnamn).

6 Klicka pa SAVE (SPARA).

OBSERVERA: Mer information om de uppgifter som visas i CSV-filer finns i bilagan for
CSV-data.

Nu har CSV-filen sparats pa datorn, dar du valt att den ska sparas. Om du vill kan du vilja att
importera den till ett program som stoder den har filtypen.
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Systemadministration

Det ar valdigt viktigt att du regelbundet gor en sdkerhetskopia av CarelLink Pros databas. |
databasen sparas alla systemuppgifter som samlats i patientens journaler, inklusive
information om profilen, uppgifter som hérletts fran enheten och rapportinstallningar.

Det ar ocksa viktigt att du har den senaste versionen av CareLink Pro. Versionerna uppdateras
regelbundet och kan innehalla viktiga férbattringar. Du kan antingen vilja att leta efter
uppdateringar eller fa ett meddelande om nar de ar tillgangliga.

Programvaruuppdateringar

Vid olika tillfallen kommer programvaran till CareLink Pro att uppdateras. Gor sa har nar du
far ett meddelande om att det finns en uppdatering.

OBSERVERA: Gor en sdikerhetskopia av databasen innan programvaran uppdateras. Se
Sdkerhetskopiera databasen pa sidan 48.

1 Kontrollera att din dator har en aktiv Internet-anslutning.

2 Meddelandet CarelLink Pro Update visas nar det finns en uppdatering av CareLink Pro. Du kan

da vélja att ladda hem uppdateringen.

3 Klicka pa DOWNLOAD (LADDA HEM). (Om du klickar pa CANCEL (AVBRYT) stangs
meddelandet om uppdatering. Du kan ladda hem uppdateringen vid ett senare tillfdlle.)

Ett varningsmeddelande visas som rekommenderar dig att ta en sdkerhetskopia pa din
databas.

4 Klicka pa YES (JA) for att skapa en sdkerhetskopia av databasen (se Sdkerhetskopiera
databasen pa sidan 48). Klicka pa NO (NEJ) om du redan har gjort en sdkerhetskopia.

Ett meddelande visas som bekraftar att den nya versionen av CareLink Pro har laddats ner.
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5 Klicka pa YES (JA) for att stdnga och 6ppna programvaran pa nytt om du vill borja anvanda
den senaste versionen av CarelLink Pro. Klicka pa NO (NEJ) om du foredrar att starta om
CareLink Pro vid ett senare tillfalle.

Avstangning av automatiska uppdateringar

GOr s har om du inte vill f& automatiska meddelanden om uppdateringar av CareLink Pro:

1 Valj Tools > Options (Verktyg, Alternativ).

2 Klicka pa fliken General (Allmant).

3 Avmarkera rutan bredvid Automatically check for software updates (S6k automatiskt efter
programuppdateringar) i avsnittet Communications (Kommunikationer).

Manuell kontroll av uppdateringar

Du kan nar som helst manuellt kontrollera om det finns nagra CareLink Pro-uppdateringar.

OBSERVERA: Gor en sdkerhetskopia av databasen innan programvaran uppdateras. Se
Sdkerhetskopiera databasen pa sidan 48.

1 Kontrollera att din dator har en aktiv Internet-anslutning.
2 Vilj Tools > Check for Software Updates (Verktyg, Sok efter programuppdateringar).

3 Om det inte finns nagra uppdateringar tillgangliga visas ett meddelande om detta. Om det
finns en uppdatering visas ett meddelande om CareLink Pro-uppdatering.

4 Folj procedurerna under Programvaruuppdateringar pa sidan 47.

Sakerhetskopiera och aterstalla databasen

Det ar en bra idé att ha ett regelbundet schema for sdkerhetskopiering av databasen. Pa sa
satt ar du sdker pa att det gors regelbundet och darmed minskar risken for att uppgifter gar
forlorade.

Om du sdkerhetskopierar eller aterstaller databasen visar systemet ett varningsmeddelande
om det dr ndgon som anvander programvaran pa en annan dator.

Sakerhetskopiera databasen

GOr sd har for att gora en sdkerhetskopia av databasen.

1 Kontrollera att alla patientjournaler ar stangda.

2 Vilj Tools > Backup Database (Verktyg, Sdakerhetskopiera databas).

OBSERVERA: Scikerhetskopior av databasen kan sparas pa en nditverksenhet eller pa
ett flyttbart lagringsmedium (DVD, CD eller USB-stick).
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3 Navigera till platsen dar du vill spara sdakerhetskopieringsfilen pa datorn. Om du vill dndra
filens namn ska du skriva in det i rutan File name (Filnamn).

4 Klicka pa Spara (Spara). En forloppsindikator visas medan databasen sparas.
Ett meddelande visas nar sdakerhetskopieringen ar klar.

5 Klicka pa OK for att stinga meddelandet.

Aterstilla en databas

Det kan handa att databasen maste bytas ut om den inte ldngre kan 6ppnas eller anvandas.
Ju nyare sdkerhetskopian ar, desto farre uppgifter gar forlorade om du maste ersatta
databasen.

OBS! Ndir du dterstdller databasen med en scikerhetskopia gdr alla uppgifter som skapats i
den nuvarande databasen efter den valda sdkerhetskopian férlorade.

GOr sa har for att vélja en sdkerhetskopia som ska ersatta den aktuella databasen.
1 Kontrollera att alla patientjournaler ar stangda.
2 Vilj Tools > Restore Database (Verktyg, Aterstilla databas).

3 Valj den sdkerhetskopia du vill anvanda for att ersdtta den aktuella databasen (oftast den
senaste).

4 Klicka péd Open (Oppna). Ett varningsmeddelande visas for att pdminna dig om att alla
uppgifter kan ga forlorade om du fortsatter med aterstdllandet av databasen.

5 Klicka pa OK for att fortsatta. En forloppsindikator visas medan databasen aterstalls.
Ett meddelande visas nar databasen ar aterstalld.

6 Klicka pa OK for att stanga meddelandet.

Om systemet inte ar tillgangligt

Om du forsoker starta systemet medan en annan anvandare sdakerhetskopierar eller utfor en
aterstallning, visas ett meddelande om att systemet inte ar tillgangligt. Du kan inte anvanda
systemet forrdn uppgiften ar klar.

Gor nagot av foljande:
- Vanta tills processen ar fardig och systemet ar tillgangligt igen.

«  Klicka pd CANCEL (AVBRYT) for att avsluta och férsoka igen senare.
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Felsokning

Det har avsnittet hjalper dig att [6sa problem som kan uppsta nar du anvander programvaran
CarelLink Pro. Det innehaller ocksa instruktioner for hur du avinstallerar CareLink Pro, ifall det
skulle behovas.

Allméanna fel

Om du forsoker hamta en uppdatering av programvaran fran Internet kan det handa att du far
ett meddelande om att du inte ar auktoriserad att gora det. Du maste ha
administratdrsbehorighet for att fa hamta uppdateringar av CareLink Pro.

1 Stang CareLink Pro och starta om datorn.
2 Be nagon med administratorsstatus logga in pa datorn.

3  Folj instruktionerna under Programvaruuppdateringar pa sidan 47.

Inte ansluten till databasen

Ett felmeddelande som anger att du inte ar ansluten till databasen innebar nagot av féljande:

. Databasen har flyttats. Databasen maste vara pa samma plats som valdes da programvaran
Carelink Pro installerades. Om den har flyttats maste den flyttas tillbaka till den plats som
valdes under installationen.

« Du dr inte ansluten till den natverksenhet ddr databasen ligger. Om databasen ligger pa en
natverksenhet kan det handa att natverket har vissa problem som gor att du inte kan komma
at stationen. Du ar inte ansluten till den natverksenhet dar databasen ligger.

Glomt klinikens losenord till CareLink Pro

Om ingen kommer ihdg det I6senord som kliniken anvander for att logga in till CareLink Pro
madste CareLink Pro installeras pa nytt och en ny databas skapas. Nar du har ominstallerat
programvaran kommer du inte at ndgon patientinformation i den féregdende databasen.
Forvara I6senordet som du skapade under den nya installationen pa en sdker plats sa att inga
framtida uppgifter gar forlorade.
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Fel vid avlasning av enheten

Den seriella port som valdes kan inte 6ppnas. Det kan
hénda att en annan handling utférs pa den porten.
Vénta tills porten blir ledig eller vélj en annan port.

Enheten hittas inte i den seriella port som valts.
Kontrollera kabelanslutningen, enhetens batteri och
status och forsok igen. Prova med att specificera en
annan port eller prova med Auto Detect.

Ovéntad respons... forsoker igen (n%)

Pumpen doserar en tempordr basaldos. Avbryt den
temporédra basalen eller vanta tills den ar slutford och
forsok sedan pa nytt.

Pumpen doserar en bolus. Avbryt bolusen eller vanta
tills den &r slutford och forsék sedan pa nytt.

Bekrafta att kommunikationsporten inte anvands av
nadgot annat program eller vélj en annan port.
Forsok att starta om datorn som du anvander och
forsok sedan att lasa av enheten igen. Det kan vara
nagot fel pd den maskinvara (t.ex. kabeln) som
anslutits till porten eller ett fel pa sjalva porten.
Anslut maskinvaran till en annan port och férsok
ldsa av enheten igen, for att avgdra om det var
problemet.

Kontrollera anslutningen mellan kabeln och datorn
samt att batteriets status ar OK. Om dessa &r bra,
prova antingen att vélja en annan seriell port pa
datorn eller valj alternativet Auto Detect.

Ett ovdntat varde ldstes av fran enheten. Systemet
forsoker ateruppta kommunikationen tills det att du
avbryter eller tills kommunikationen lyckas.

Den pump du férséker ldsa av doserar en temporéar
basaldos. Vanta antingen med att avldsa pumpen
tills den tempordra basaldosen ar avslutad eller
avbryt den temporéra basaldosen och las sedan av
pumpen.

Den pump du forsoker ldsa av doserar en bolus.
Véanta antingen med att avldsa pumpen tills
bolusen ar avslutad eller avbryt bolusen och las
sedan av pumpen.
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Fel vid skapande av rapporter

Flera uppgifter for samma datum

Om det finns flera uppgifter for samma datum och tid for samma enhet sa betraktar systemet
det som en konflikt som inte kan l6sas. Rapporter som skapas med dessa uppgifter utelamnar
den del av uppgifterna som 6verlappar varandra.

Du kan forsoka anpassa rapporteringsperioden sa att de dverlappande uppgifterna
utelamnas. Eller sa kan du ta bort enheten fran systemet och sedan lagga till den igen sa att
de tidigare avlasningarna raderas.

Systemet kommer att ignorera uppgifterna

Om tiden pa en enhet har dndrats sa att det ger dverlappningar eller utelamnade uppgifter pa
tre timmar eller mer tar inte systemet med dessa uppgifter da rapporterna skapas.

Sakerhetskopierings- och aterstallningsfel

Databasen kan inte lasas

Det innebar att du anvander systemet i en miljo med flera anvandare och att andra anvandare
var inloggade. Systemet tilldter inte en sdkerhetskopiering av databasen samtidigt som andra
anvandare kan utfora uppgifter som kan paverka databasen. Du kan gora en sdkerhetskopia
av databasen nar alla andra anvandare har slutat att anvanda CareLink Pro.
Sakerhetskopieringen eller aterstillandet av databasen slutférs inte

Andra anvdndare kan inte logga in och sakerhetskopieringen eller aterstallandet kan inte
slutféras. Kontakta Medtronic-representanten (se Hjélp pad sidan 2).

Aterstillandet av databasen misslyckas

Det ar nagot fel pa den sdkerhetskopia av databasen som du férséker anvanda for
aterstdllandet. Forsok aterstdlla med en annan sdkerhetskopia.

Avinstallera programvaran

GOr sa har for att avinstallera CareLink Pro:

1 Oppna Kontrollpanelen frdn Windows Startmeny.

Valj Lagg till eller ta bort program. Fonstret Lagg till eller ta bort program visas.
Bladdra ner till Medtronic CareLink Pro och klicka pa detta alternativ.

Klicka pa Ta bort. Installationsguiden visas.

Klicka pa Nasta. Ett meddelande visas som ber dig bekréfta att du vill ta bort programmet.

N un A W N

Klicka pa Yes (Ja). Avinstallationsprogrammet kors och tar bort programmet och alla dess
filer fran din dator. Nar det &r klart visas ett meddelande pa skarmen som bekréaftar

avinstallationen.
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7 Klicka pa Finish (Slutfor).
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Symbolforteckning

Ikonerna och symbolerna pa forpackningsetiketten och utrustningen beskrivs i foljande tabell.

En per behadllare/férpackning

Obs: Las alla varningar och forsiktighetsatgarder i A
instruktionerna.

Referensnummer REF
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CSV-data

Nar du exporterar rapportuppgifter fran CareLink Pro exporteras uppgifterna till en CSV-fil.
Denna fil kan sedan importeras till ett kalkylprogram, t.ex. Microsoft Excel. Fér en komplett
lista Over de data som kan finnas i en CSV-fil, se kolumndefinitionerna for CSV-filer.

CSV-filen innehaller patientens namn, ID och rapporteringsperioden, och identifierar varje
enhet som ingar i rapporten.

Definition av kolumnerna

Den ordning i vilken uppgifterna registrerades i
Index
enheten.

Time (Tid) Den ordning i vilken tiden registrerades i enheten.

Det blodsockervdrde som registrerats av mataren,
Guardian eller pumpen. Om uppgifterna kommer fran
en pump eller Guardian, ar vardena i kolumnen
manuella BS-vdrden och BS-védrden fran en Link-
matare.

BG Reading (mg/dl or mmol/l) (BS-varde (mg/dl eller
mmol/l))

Basal Rate (U/h) (Basaldos (E/tim)) Den aktiva basalinsulindosen i enheter per timme.

Typ av tempordr basaljustering (insulindos eller
Temp Basal Type (Temp basaltyp) procent av basaldosen).

Doseringstyp for bolusinsulin [normal, forlangd,
Bolus Type (Bolustyp) dubbel (normal del) eller dubbel (férlingd del)].
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Bolus Volume Delivered (U) (Doserad bolusvolym (E))

Prime Type (Primetyp)

Rewind (Aterstall pump)

BWZ Target High BG (mg/dL or mmol/L) (Bolusguide
hoégt BS (mg/dl eller mmol/l))

BWZ Carb Ratio (Bolusguide kolh.kvot)

BWZ Carb Input (Bolusguide kolh.kons.)

BWZ Correction Estimate (U) (Bolusguide
korrektionsberdkning (E))

BWZ Active Insulin (U) (Bolusguide aktivt insulin (E))

Antalet insulinenheter som verkligen doseras under
bolusinsulindosering.

Manuell eller fast. Manuell anvands omedelbart efter
en aterstdllning, for att fylla infusionssetet med
insulin innan det satts in. Fast anvands efter att
infusionssetet satts in for att fylla den mjuka kanylen
med insulin efter att mandrdngen har tagits ut.

Namnet pa det alarm som gatt.
Datum och tid for aterstélining av enheten.

Instéliningen for det hogre gransvardet for
blodsocker, som anvands av bolusguidefunktionen.

Instéllning for insulin-kolhydratkvoten. Om enheten
gram anvands ar denna kvot mangden kolhydrater i
gram som tacks av en enhet insulin. Om enheten
utbyten anvands ar denna kvot det antal
insulinenheter som anvénds for att tacka ett
kolhydratutbyte.

Mangd kolhydrater som anges i bolusguiden och
anvands for att berdkna bolus.

Antal enheter bolusinsulin som ska ges for att
korrigera blodsockervérdet, berdknat av funktionen
Bolusguide.

Maéangden aktivt insulin som beraknats ska finnas
kvar i kroppen fran tidigare bolusinsulindoser nar
bolusméngden ska berdknas med funktionen
Bolusguide.
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Sensor Glucose (mg/dL or mmol/L) (Sensor-BS (mg/dl

eller mmol/)) Sensorglukosvardet.

SE e T8EaEEE Innagn;i)r;%s]srlg:\eal(enrA()lSIG), lases fran sensorn och maits i

Mer om CSV-filer som exporteras av CarelLink Pro

Titeln 6verst i en CSV-fil innehaller féljande information:

- patientens namn

« en lista med valda enheter och deras serienummer

« valda datum

Varje block med kolumner har en titel som innehdller det foljande:
« namnet pa den enhet uppgifterna galler for

« serienumret pa den enheten

Om uppgifterna inte visas som forvantat

Det ar flera olika faktorer som kan gora att CSV-uppgifterna visas pa ett annat satt an
forvantat.

«  Andringar av datum eller tid pd enheten kan dndra sekvensen eller ge registreringar utanfor
det valda datumomradet.

« Om det finns en stor lucka mellan avldasningarna av enheten kan det handa att uppgifterna
for den enheten visas i flera block.
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Ordlista

A1C- Glykosylerat hemoglobin
A1C-test - Hemoglobin A1C-test, som anvands for att tolka blodsockervarden under en tidsperiod.

Arean under kurvan (AUK) - Visar omfattningen av hoga och laga avvikelser, faststallda enligt de
forinstallda vérdena. Avvikande data anger hur ofta vardena var for hdga eller for ldga. AUK visar
handelsernas omfattning genom att visa hur langt utanfér omraddena de lag och under hur lang
tid.

Basaldos - Pumpinstallning som ger I6pande insulininfusion for att halla blodsockret stabilt mellan
maltiderna och under natten. Basalinsulin efterliknar bukspottkértelns utsondring av insulin och
uppfyller din kropps insulinbehov utanfér maltiderna.

Basalinsulin - En kontinuerlig mdngd insulin per timme som doseras automatiskt av insulinpumpen,
grundad pa forprogrammerade profiler for personliga doser som stéllts in i pumpen. Pumpen
doserar en daglig méngd insulin som normalt sett tacker bakgrundsbehovet av insulin under
perioder med fasta (t.ex. nattetid och mellan maltiderna).

Basalprofil - En basaldos med en start- och en stopptid. Anvdandaren kan programmera in flera olika
profiler i pumpen, var och en med sin egen basaldos, under en 24-timmarsperiod, for att fa battre
glukoskontroll.

Basalprogram - Anvandaren kan programmera upp till tre olika basalprogram i pumpen for dosering
av basalinsulin: Standard, A och B. Varje program har méjligheten att stdllain upp till 48 basaldoser.

Bolusinsulin - En dos insulin som doseras for att tacka en forvantad hdjning av blodsockret (som
t.ex. hojningen efter en maltid eller ett mellanmal) eller for att sanka ett hogt blodsocker ner till
malvardet.

BS - Forkortning av blodsocker
CareLink’ Personal - En onlinetjénst som kan hantera diabetesuppgifter via Internet.

ComLink - En radiofrekvensenhet (FR) med sdandare och mottagare som anvands for att hamta
uppgifter fran Paradigm-pumpen till datorn.

Com-Station - En enhet som anvands for att hamta uppgifter fran pumpen MiniMed 508 och
vidarebefordra uppgifter fran andra tillverkares matare till datorn.

Dual Wave’ (dubbel) bolus - En kombination av normal bolus som doseras omedelbart och darefter
foljs av en forlangd bolus. Férlangd bolus doserar jamnt under en period.

Expressbolus - En tillsatsmetod for valfri bolustyp som anvénder sig av pumpens express bolus-
knapp.

Forlangd del - Den andra delenien dubbel bolus. Den forlangda delen doserar jamnt dver en period
sedan NU-delen doserats.
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Forlingd (Square Wave®) bolus - Bolus som avges jamnt under en specificerad tidsperiod (30
minuter till 8 timmar).

Genomsnittlig absolut differens i % (MAD %) - Visar noggrannheten hos sensorkalibrering jamfort
med BS-mataravlasningar. Ju lagre denna siffra ar, desto hogre blir kalibreringsnoggrannheten.
MAD % beraknas genom att differensen mellan narliggande par av sensorglukos- och BS-
mataravlasningar tas, delat med BS-mataravlasningen och sedan réknas ett genomsnitt for
samtliga par ut.

HbA1c - Glykosylerat hemoglobin

HbA1C-test - Hemoglobin A1C-test, som anvands for att tolka blodsockerkontrollen eller
genomsnittet av vardena under en period pa 2-3 manader.

Hyperglykemisk - Forhojt blodsocker som upptacks vid dvervakningen av blodsockervardena, med
eller utan ndgot eller alla av de féljande symptomen: illamdende, krdkningar, suddig syn,
huvudvark, orolig mage, att kissa ofta och stora mangder samt apati.

Hypoglykemisk - Lagt blodsocker som upptdcks vid vervakningen av blodsockervardena, medeller
utan nagot eller alla av de féljande symptomen: extrem hunger, skakningar eller darrningar,
svettning, "dansande" syn, yrsel, huvudvark, sluddrande tal, plotsliga humaorsvangningar eller
personlighetsforandringar.

Hogt BS - Pumpen utldser ett alarm om sensorn indikerar att anvéandarens sensorblodsocker &r lika
med eller Over detta varde. Du kan aktivera eller inaktivera den har funktionen som du vill.

Infusionsset - Den apparat som anvadnds for att fora in och sédkra en kanyl under huden och
transportera insulin till insticksstallet genom slangar fran pumpen.

Insulinkoncentration - Styrkan eller typen av insulin som lakaren skrivit ut at anvandaren. Detta
paverkar den insulindos som pumpen doserar. Om anvdndarens insulinkoncentration andras
maste basalprofilerna och de hégsta basal- och bolusdoserna programmeras om i pumpen.

Insulinkdnslighet - Hur mycket i mg/dl (eller mmol/I) din blodsockerniva (BS-niva) férandras av en
enhet insulin. (Bolusguidedata.)

ISIG - Sensorvdrden som anger om sandarens elektronik i ett sensorforstarkt system fungerar korrekt.
Ring for produktassistans om du ser ett ISIG-varde som ligger under 24,00 nA eller dver 29,00 nA.
Det kan vara dags att byta ut din sandare.

Kalibreringspaminnelse - Pumpen utloser automatiskt ett “matare BS per TT:MM-alarm” var tolfte
timme fOr att signalera att det aktuella kalibreringsvardet inte galler langre. Kalpdminnelsevardet
anger tidsperioden tills dess att det aktuella kalibreringsvardet I6per ut och anvandaren vill bli
pamind om att kalibrera. Om kalpdminnelsen exempelvis star pa tva timmar sa avges BS per
TT:MM-alarmet tva timmar innan kalibrering kravs.

Ketontest - Ketoner ar en avfallsprodukt som produceras nar kroppen tvingas att forbranna
kroppsfettistallet for blodsocker for att fa energi. Det kan vara ett tecken pa insulinbristi kroppen.
Ketontestet mater ketonkoncentrationen i blodet eller urinen.

KH - Kolhydrater

Kolh. kvot (Kolhydratkvot) - Den mangd kolhydrater som tacks av en enhet insulin. (Se dven
utbyteskvot).

Kolhydratenheter - Matintag med Bolusguide. Fors in som (kolhydrat) gram eller utbyten.

Korrektionsbolus - Den mangd insulin som behdvs for att fa ned den hoga blodsockernivan till
malvardet.

Korrektionsbolusfaktor - Hur mycket 1,0 enhet insulin sanker blodsockret. Denna faktor anvands
for att berakna en korrektionsbolusmangd nar blodsockret ar hégt. (BS-niva) - (BS-mal) = X. X +
(korrektionsbolusfaktor) = korrektionsbolusméangd

Ljudbolus - Pumpen kan programmeras sa att anvandarna hor en signal nar de valjer en
bolusinsulinmangd (0,5 eller 1,0 enheter) som ska doseras. Den har funktionen ar praktisk i lagen
dar det ar svart att se knapparna pa pumpen.

Ljudbolus™ - Doseringsmetod for en normal bolus som anvander Easy bolus-knappen pa pumpen.
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Lagt BS - Pumpen utloser ett alarm om sensorn indikerar att anvdandarens sensorblodsocker ar lika
med eller under detta varde. Du kan aktivera eller inaktivera den har funktionen som du vill.
Lank

(1) Att sl pa och stalla in det mataralternativ som gor det mojligt for pumpen att ta emot BS-
varden fran en matare som kommunicerar med din pump.

(2) Termen anvdnds aven i det har systemet som hanvisning till hypertextlankar. Om du klickar pa
en hypertextlank kommer du till ett annat stalle i systemet eller till en annan hemsida.

Manuell bolus - Valfritt alternativi BOLUSMENYN nar bolusguiden ar aktiv. En metod for att
programmera en bolus utan bolusguiden.

Max basalinsulin - Den maximala mangd basalinsulin som pumpen ar installd pa att dosera per
timme. (stalls in av anvandaren)

Max bolus - Den maximala mangd bolusinsulin som pumpen ar installd pa att dosera per timme.
(stalls in av anvandaren)

Maltidsbolus - En dos insulin som doseras for att tacka den forvantade héjningen av blodsockret
efter en maltid.

Mataralternativ - Funktion som gor att pumpen tar emot BS-vdrden fran en lankad
blodsockermadtare.

Matare - Ett medicinskt instrument som avgor det ungefarliga blodsockervardet i blodet. En liten
droppe blod ldggs pa en testremsa, som mataren sedan ldser av och anvander for att berdkna
blodsockervardet. Mataren visar sedan vardet i mg/dl eller mmol/I.

Normal bolus - En omedelbar dosering av en specificerad mangd insulin.

Program, standard - Din normala basaldos for dina dagliga aktiviteter. Nar programfunktionen ar
avstangd, anvander pumpen ditt standard(basal)program.

Programfunktion - En pumpfunktion som later dig programmera valfria basaler (Program A,
Program B) som uppfyller insulinbehov for aktiviteter eller blodsockermdnster som inte ar en del
av dina dagliga rutiner, men som anda forekommer i din livssituation. Det kan t.ex. vara en
idrottsaktivitet som du utfor en gang per vecka, andrade sovvanor under veckosluten eller
hormonférandringar under menstruationen.

RF - Radiofrekvens (RF)
Steg - Installda antal enheter insulin per knapptryckning vid Ljudbolus-dosering.

Stoppa - En funktion hos pumpen som stoppar all insulindosering. Alla pagdende bolus- och/eller
primedoser avbryts. Basaldoseringen avbryts temporart tills den aterstartas.

Sandar-ID - Serienummer pa den sandare som for tillfdllet anvands.
Temp - Temporar

Temporar basal - Temporar dosering av basalinsulin avengdngstyp med en specificerad mangd och
varaktighet. Anvands for att fylla insulinbehov for speciella aktiviteter och situationer som inte
tillhor de normala, dagliga rutinerna.

Utbyteskvot - Den mangd insulin som behdvs for att tacka ett (1) kolhydratutbyte. (Se dven
kolhydratkvot).

Varning for lag reservoarvolym - Programmerbar varning, som antingen uppmarksammar dig pa
att ett specificerat antal enheter finns kvar i pumpreservoaren eller att en specificerad tid aterstar
innan reservoaren ar tom.

Overfora - Processen att fora dver uppgifter frén pumpen eller mitaren till CareLink® Personal-
servern.
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ansluta enheter till datorn 25
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lagga till en enhet i systemet 29

lagga till en Guardian-monitor till systemet 29
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lagga till en patient 21
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Guardian-monitor 29
madtare 31
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instdllning, preferenser for rapport-
generering 16
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